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1. About this manual

1. About this manual

This manual allows you to become acquainted with the
product.

Observe the safety regulations applicable for each country.
You can contribute to the durability and reliability of the
product during its use by handling it carefully. These are
basic prerequisites for optimum use of your product.

1.1 Purpose of this manual

This manual is part of the product. Store the manual in a
safe place.

Read the manual carefully and thoroughly and follow the
instructions contained therein. The manual contains impor-
tant information on the installation, commissioning and
operation of the solar power inverter.

Take note of and follow the information on safe use (see “3.
General safety instructions”, p. 7).

The installer and the operator must have access to this
manual and must be familiar with the safety instructions.

The solar power inverter can be operated safely and nor-
mally only if it is installed and operated in accordance with
this manual (see IEC 62109-5.3.3). Delta Energy Systems
is not responsible for damage incurred by failure to com-
ply with the installation and operating instructions in this
manual.

1.2 Target audience of this manual

This manual is aimed at qualified electricians.

Only chapters “9. Production information”, p. 37 and “12.
Diagnosis and maintenance”, p. 48 are relevant to the opera-
tor. All other activities may only be performed by qualified
electricians.

1.3 Warnings and symbols

The following section explains the warnings and symbols
used in this manual.

Indicates a dangerous situation.
A DANGER An accident will lead to death or

severe physical injuries.

_ Indicates a dangerous situation.
An accident can lead to death or

severe physical injuries.

A CAUTION Indicates a dangerous situation.
An accident can lead to medium
or light physical injuries.
ATTENTION Indicates a dangerous situation

that can result in material dam-
age.

NOTE Contains general information on

using the solar power inverter. A
note does not indicate danger-
ous situations.

This symbol warns of a danger of electric
shock due to the presence of high voltages.

This symbol is a warning of general dan-
gers.

1.4 Conventions used in this document

141 Work steps

Numbered sequences of work steps must be performed in
the specified sequence.

1. Work step

—  When the solar power inverter reacts to a work
step, then this reaction is marked with an arrow.

2. Work step

3. Work step

The end of a sequence of work steps is marked as follows:
M Endofa sequence of work steps

An instruction consisting of only one work step is shown as
follows:

» Work step

1.4.2 User buttons and LEDs

User buttons and LEDs are marked in this document as
follows:

User buttons on the solar power inverter: [ES() button.

LEDs on the solar power inverter: FaiLure LED

LED symbol Meaning
\\.// The LED lights up continuously.
N The LED flashes.
.
@) The LED is off.
1.4.3 Software elements

Software elements as menus and input fields are marked in
this document as follows:

Software menu elements: User settings menu

You change the value of a parameter in data entry fields. All
types of data entry fields on the display are shown as fol-
lows: Cos Phi data entry field.
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2. Intended purpose

2. Intended purpose

This solar power inverter in the EU series may be used in
the following countries (Status 02.07.2012):

Country SOLIVIA

25 30 33 36 5.0

Belgium X X X X
Bulgaria X X X X
Danmark X X X X X
France X X X X
Germany X X X

Great Britain

Greece X X X X
Italy X X X X
The Netherlands X X X X
Portugal X X X X
Romania X X X X
Slovakia

Slovenia X X X X
Spain

This list may change due to current approval processes. If
you have any questions, please contact the Delta Support
Team.

The solar power inverter connects a photovoltaic system to
the public power grid. The solar power inverter converts DC
electricity into AC electricity, which is then fed into the public
power grid.

The solar power inverter is intended for use in photovol-
taic systems connected to a power grid. The solar power
inverter is not intended for mobile use.

The solar power inverter can be used indoors and in pro-
tected outdoor areas with ambient conditions according to
IP65.

The solar power inverter may only be used within the speci-
fied power range and under the specified ambient condi-
tions.

The solar power inverter contains monitoring devices,
including an anti-islanding device.

The solar power inverter may only be used for the specified
intended purpose.

3. General safety instructions

Danger of death from hazardous voltage
Hazardous voltage is applied to the solar
power inverter during operation. Hazardous

voltage is still present 5 minutes after all

power sources have been disconnected.

» Never open the solar power inverter.
The solar power inverter contains no
components that are to be maintained
or repaired by the operator or installer.
Opening the cover will void the war-
ranty.

e Incorrect handling can lead to physical injuries and
material damage!

The installation and commissioning work may be per-
formed only by qualified electricians.

EN

The solar power inverter can be operated safely and
normally only if it is installed and operated in accor-
dance with this manual (see IEC 62109-5.3.3). Delta
Energy Systems is not responsible for damage incurred
by failure to comply with the installation and operating
instructions in this manual.

The solar power inverter contains no components that
are to be maintained or repaired by the operator or
installer. All repairs must be performed by Delta.

Observe all points in this installation and operation
manual!

Before working on the solar power inverter, you must
disconnect it from the grid and the PV modules.

Do not disconnect any cables when the solar power
inverter is under load, as there is a risk of an arc fault.

To prevent lightning strikes, follow the regulations ap-
plicable in your country.

The surface of the solar power inverter can get very
hot.

The solar power inverter is heavy (see “15. Technical
data”, p. 56). The solar power inverter must always be
lifted by two people.

The solar power inverter has a high leakage current
value (see “15. Technical data”, p. 56). The ground wire
MUST be connected before the start of operation.

Only equipment in accordance with SELV (EN 60950)
may be connected to the RS485 and USB interfaces.

Do not remove any warning signs that the manufacturer
has installed on the solar power inverter.

In order for IP65 protection to be granted, all used and
unused connections must be sufficiently sealed.
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4. Unpacking

4. Unpacking

A warnne

Danger of injury due to heavy weight

The solar power inverter is heavy (see “15.

Technical data”, S. 56). Incorrect handling

can lead to injuries.

» The solar power inverter must always
be lifted by at least two people. Or use
an appropriate lifting device, e.g., a
crane.

Check the scope of delivery for completeness:

Mounting plate (a)

Operation and installation manual (b)
Wieland RST25i3S AC plug (c)

1/O interface plug

2 M6 nuts and 2 M6 washers (d)
"Power limit" label (e)

Solar power inverter (f)

Check all parts for signs of damage!

Store the packaging in a safe place!
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5. System description

5. System description

5.1 General overview

Fig. 5.1.: Components of the solar power inverter

No. Meaning Description

@ Status LEDs “5.3 Status LEDs”, p. 11

@  Display and buttons “5.4 Display and buttons”, p. 11
®  Type plate “5.2 Type plate”, p. 10

@ Electrical connections “5.5 Electrical connections”, p. 15
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5. System description

5.2 Type plate

ogme ogme ogme

SOLiVi4 2.5 TR SOLivi4 3.0 TR SOLiVi4 3.3 TR

DC operating volt. range: 125-600V — DC operating volt. range: ) 125-600V = E: DC operating volt. range: 125-600V =

DC operating volt. range (MPP):  150-480V — b DC operating volt. range (MPP):  150-480V = i DC operating volt. range (MPP): 150-480V — He

DC max. input voltage: 600V — ;‘@'-.‘l DC max. input voltage: 600V = T DC max. input voltage: 600V = ?JJ

DC max. operating current: 18.2A DG max. operating current: 22.0A DC max. operating current: 24.0A

DC max. current per string: 17A DC max. current per string: 17A DC max. current per string: 17A

AC nom.output voltage: 230V N AC nom.output voltage: 230V N AC nom.output voltage: 230V N

AC nom.output frequency: 50Hz N AC nom.output frequency: 50Hz N AC nom.output frequency: 50Hz N

AC max. continuous output current: 17.0A N AC max. continuous output current: 17.0A N AC max. continuous output current: 17.0A N

AC max. continuous output power:  2500VA AC max. continuous output power: ~ 3000VA N AC max. continuous output power:  3300VA

AC power factor Cap 0.8~Ind 0.8 N AC power factor: Cap 0.8~Ind 0.8 N AC power factor: Cap 0.8~Ind 0.8 N

PR N wiiie’ CE BgS B R M N

VDE-AR-N-4105 ; ; VDE-AR-N-4105 c E s ;

Country specific standards and settings: gg:a:;ynil;?mf‘c standards and settings: ; Country specific standards and settings:

see manual ; see manual ;

IP class: 1P65 ) 6 > IP class: 1P65 6 Y > IP class: 1P65 C: >

Safety class: 1 / >- Safety class: 1 d >- Safety class: 1 & >-

Ambient temp: -25C...+70C, deratlng >65C x Ambient temp: -25C.+70<, derating >55C x Ambient temp: -25C...+70C, derating >55C x

SOLIVIA2.5EUG4 ) > SOLIVIA3.0EUG4 et > SOLIVIA3.3EUGATR s b9

EOE46010288 = = EOE46010287 : = EOE46010252 S =S

Rev: XX Rev: XX E Rev: XX

Date code:  YYWW E Date code:  YYWW Date code:  YYW! E

SIN: LLLMMMXXYYWWZZZZZZ E SIN: LLLMMMXXYYWWZZZZ7Z E LLLMMMXXYYWWZZZZZZ E
- -
- A - A -

A\ nELTa = AELTA 3 AELTA =

www.solar-inverter.com an www.solar-inverter.com =n www.solar-inverter.com u

Designed in: Germany (/)] Designed in: Germany (7)) Designed in: Germany (/)]

Made in:  production plant Made in:  production plant Made in:  production plant

Fig. 5.2.:

Solivia 2.5 G4 TR type plate

Fig. 5.3.:

Solivia 3.0 G4 TR type plate

SOLiVi4 3.6 TR

DC operating volt. range: 125-600V —

DC operating volt. range (MPP): 170-480V — Y . i
DC mpax. inp%t voltage? ¢ ) 600V — % DC max. input voltage: 600V — ii'
DC max. operating current: 22.0A DC max. operating curr_enl: 37A
DC max. current per string: 17A DC max. current per string: 18A
AC nom.output voltage: 230V AC nom.output voltage: 230220V
AC nom.output frequency: 50Hz AC nom.output frequency: 50|60Hz
AC max. continuous output current:  17.0A AC max. output current: 27.2|28.5A
AC max. continuous output power:  3600VA AC nom. output power: 5000W
AC power factor Cap 0.8~Ind 0.8
IEC 60950-1 C €
EN 50178
VDE 0126-1-1(D; ‘% g
o) IEC 62103 =

SOLiVi4 5.0 TR

DC operating volt. range (MPP):  150-480V ==

VDE-AR-N-4105

Country specific standards and settings:

(€ Oed

IEC 62109-1 and IEC 62109-2
Country specific standards and settings:

Fig. 5.4.:

Solivia 3.3 G4 TR type plate

see manual see manual
IP class: IP65 A}
IP class: P65 6 6 :
Safety class: 1 [ji] A & Safety class: 1
Ambient temp: -25C..+70C, derating >55C Ambient temp: -20°C...+70°C, deraung >55°C
SOLIVIA3.6EUG4 e SOLIVIA5.0EUG4TR e
EOE46010316 5 EOE46010253 5
Rev: XX
IH):;/e code: ééww Date code:  YYWW
LLLMMMXXYYWWZZZZZZ SIN: LLLMMMXXYYWWZZZZ7Z

LLLMMMXXYYWWZZ2Z27227Z %

LLLMMMXXYYWWZ2Z2Z227Z

A AELTA

www.solar-inverter.com

A NELTA

Designed in: Germany
Made in: production plant

SN
SN

Designed in: Germany
Made in: production plant

Fig. 5.5.: Solivia 3.6 G4 TR type plate Fig. 5.6.: Solivia 5.0 G4 TR type plate

Warning symbols on Description
the type plate

(s

Danger of death from hazardous voltage

Hazardous voltage is applied to the solar power inverter during operation. Hazardous voltage is still

present 5 minutes after all power sources have been disconnected.

» Never open the solar power inverter. The solar power inverter contains no components that are to
be maintained or repaired by the operator or installer. Opening the cover will void the warranty.

» Read the manual before working with the solar power inverter and follow the instructions con-
tained in the manual.

Danger from high temperatures

During operation the housing of the solar inverter can get very hot.

» Do not touch the housing beside the orange middle part without safety gloves. The orange middle
part and the display are protected by a special surface.
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5. System description

5.3 Status LEDs

5.4.3 Buttons

Symbol Use

Exit the current menu

B

Cancel the setting of a value

T e Move upwards in a menu

Set a value (increase the value)
JL e Move downwards in a menu

Set a value (decrease the value)
Select a menu entry

@
@ .
® Operation
Earth Fault
Failure
Fig. 5.7.: Status LEDs
o
No. Label Designation Color
@®  OPERATION Operation Green
@  EARTH FAuLT Earth fault Red
®  FaiLure Failure Yellow

Information on the LED messages is provided in “12. Diag-
nosis and maintenance”, p. 48.

5.4 Display and buttons

5.4.1 Components

B0 L1 L &

Fig. 5.8.: Display components

No. Designation

@ Display

® Buttons

5.4.2 Display layout

Format
»Date: DD.MM.YYYY
Time: 12h
Fig. 5.9.: Display

The display has 4 rows of 20 characters each.

The first row contains the name of the currently displayed
menu.

The second to fourth rows show the menu elements.

A small arrow in the third row shows the currently selected
menu item.

e Open a configurable value for editing

e Finish editing (adopt the set value)

5.4.4 General menu structure

The menus have up to three levels:

[Main menu]

300 USB features
400 Production info

410 Actual data
411 Current overview
412 Actual data AC

420 Day statistics
430 Week statistics

500 User settings

Most menu names consist of a three-digit number and a
menu title.

See “16.3 Overview of menu structure”, p. 61 for an overview
of the complete menu structure.

Operation and installation manual for SOLIVIA 2.5/3.0/3.3/3.6 EU G4 TR
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5. System description

5.4.5 "Go to menu" function

NOTE
You can use the "Go to menu" function to directly

navigate to a particular menu.
1. To open the Go to menu function, press and hold the
[E8¢) button on the solar power inverter for at least 3

seconds.

Alist of the available menu numbers is provided
in “16.3 Overview of menu structure”, p. 61.

— Go to menu opens.

Go to menu

Menu: 411
411 Actual overview

2. Press the =] button to enter the menu number.
— The first digit flashes.

3. Enter the first digit of the menu number using the
buttons.

— You can only set menu numbers that actually exist.
The name of the associated menu is displayed in
the fourth display row.

4. Once you have set the first digit, press the [ button.
— The second digit flashes.

5. Enter the second and third digit in the same manner.
Press the [] button.

— The menu corresponding to the entered menu
number is displayed.

5.4.6 Button combinations

The table lists special button combinations for the display
buttons.

Action

Esc @ Pressing the and buttons at the same time

displays the 100 Install settings menu where
you can change the display language to be used,
see “10.2.1 Display language”, p. 39.

Pressing the buttons at the same time
displays the 800 Standard menu where you can
select the "standard menu", see “10.6 Standard
menu”, p. 44.

Buttons

5.4.7 Navigating in menus

You use the (L] 7] buttons for navigating in menus.

The (] button moves to the next lower menu item and the
button moves to the next higher menu item.

Solivia ##
Production info

>User settings
Diagnostic&Alarm

J T

Solivia ##

User settings
>Diagnostic&Alarm

Inverter info

J T

Solivia ##
Diagnostic&Alarm
»Inverter info
Standard

5.4.8 Selecting a sub-menu

» Press the 2] button to open a sub-menu.

Solivia ##
USB features
»Production info
User settings

o

400 Production info
Feed-in settings
>Actual data
Day statistics

5.4.9 Exiting a menu

» Press the [E(] button to return to the higher-level menu.

400 Production info
Feed-in settings
>Actual data
Day statistics

ESC

Solivia ## G4
User features
Production info
User settings

5.4.10 Setting values

You can set parameters in several menus. The but-
tons are used to change parameter values.

The [ 1] button increases the value of the parameter.

12
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5. System description

The [l ] button decreases the value of the parameter.

The @ button can be used to cancel the setting, and the
original value is then displayed once more.

Pressing the [2] button causes the new parameter value to
be adopted.

The example on the next page illustrates the procedure for
changing the value of a parameter. This procedure is the
same for all configurable parameters.

Operation and installation manual for SOLIVIA 2.5/3.0/3.3/3.6 EU G4 TR
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Example: Setting the date

Buttons

Action

Result

i)

J

1.

Press the (1] 1] buttons in the main menu to select the Install set-
tings menu.

Solivia ## G4

»Install settings
Options

o 2. Press the [=] button to open the 100 Install settings (installation set- 100 Install settings
tings) menu. ...
PLanguage: English
Date and time
P L 3. Usethe buttons to select Date and time. 100 Install settings
Language: English
»Date and time:
Display settings
o 4. Press the [2] button to open the 110 Date and time menu. 110 Date and time
»Date: 09/14/2011
Time: 03:15:22pm
T @ 5. Usethe buttons to select the Date menu item. 110 Date and time
»Date: 09/14/2011
Time: 03:15:22pm
o 6. Press the [~] button to begin making the setting
— The digits for the first value (in this case the month) flash.
09
P 1 7. Usethe buttons to set the month.
iljil
o 8. Press the [2] button to adopt the new value.
— The digits for the second value (in this case the day) flash.
14
T JL 9. Usethe buttons to set the day.
il
o 10. Press the [2) button to adopt the new value.
— The digits for the last value (in this case the year) flash.
2011
T JL 11. Use the buttons to set the year.
2012
o 12. Press the [2] button to adopt the new value.
M The value is adopted and the editing mode is exited. 110 Date and time

11/17/2012
03:15:22pm

PDate:
Time:

14
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5. System description

5.5 Electrical connections

5.5.1 Overview

usB
DC DISCONNECT
[ ]| T 1 I O A B A
L A
| | | || ||
{ | | | |
|1 1 |1 1 |1 1 |1 1 |1 1
ug U g U U0 U U U O U
Fig. 5.10.:  Electrical connections SOL
usB

Fig. 5.11.:  Elektroanschliisse SOLIVIA 5.0

No. Designation

Description

2 x RS485 interfaces

“5.5.4 RS485 interface (EIA485)”, p. 16

AC connection

“5.5.3 AC connection”, p. 16

USB interface

“5.5.5 USB interface”, p. 16

DC disconnector

“5.5.2 DC connections and DC disconnector”, p. 16

@®e|e 0

DC connections

“5.5.2 DC connections and DC disconnector”, p. 16
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5.5.2 DC connections and DC disconnector

DC INPUT MINUS

AN\ N\ /)
<!
AN\ N\ —

DC DISCONNECT

DC INPUT PLUS

Fig. 5.12.:  DC connections and DC disconnector

The DC connections are used for connecting the PV module
string(s) to the solar power inverter.

The solar power inverter is equipped with an integrated DC
disconnector for disconnecting the DC connections from the
DC voltage of the PV modules.

The maximum permissible input current is 29 A for each DC
connection.

Connection type: Tyco MultiContact MC4, pairs with plug
(DC+) and socket (DC-), 3 pairs for SOLIVIA2.5 ... 3.6, 4
pairs for SOLIVIA 5.0.

5.5.3 AC connection

The AC connection is used for connecting the solar power
inverter to the grid.

The solar power inverter is connected to the grid using a
3-wire cable (L, N, PE).

Connection type: Wieland RST25i3s, plug supplied in the
scope of delivery

5.5.4 RS485 interface (EIA485)

The two RS485 interfaces are used to connect one or more
solar power inverters to a monitoring system.

The RS485 interfaces are internally wired 1:1. This means
that both RS485 interfaces can be used as an input or an
output.

Multiple solar power inverters are connected in series. Each
solar power inverter must have a unique RS485 ID. A ter-
mination resistor must be connected to the last solar power
inverter in the series.

The RS485 ID can be set during the commissioning (see “8.
Commissioning”, p. 27) or later (see “10.2.6 RS485 (EIA485)”,
p. 41).

Connection type: 2 x RJ45

5.5.5 USB interface

The USB interface is used for saving and loading data and
reports.

Supported functions:

e Updating firmware

e Saving and loading settings
e Saving swap data

e Creating reports

e Service

See “11. Saving and loading data and settings”, p. 45 for a
detailed description of the functions.

Connection type: USB A

16
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6. Operating behavior

6. Operating behavior

6.1 General principle of operation

The solar power inverter converts the DC electricity from the
PV modules into AC electricity. The AC electricity is then fed
into the public power grid.

MPP tracker

The solar power inverter has an MPP tracker (MPP = Maxi-
mum Power Point).

The MPP tracker regularly scans a DC voltage range in the
vicinity of the actual working point in order to find a point
offering higher power. If a point offering higher power is
found then the solar power inverter sets this as the new
actual working point.

The "Shadowing" function can be used to set the MPP
tracker to scan over a wider DC voltage range. This function
is especially useful when small shadows regularly pass over
the PV modules, e.g., from chimneys or trees.

Galvanic isolation

The AC and DC sides of the solar power inverter are gal-
vanically isolated via a high frequency transformer. This
makes it impossible for DC electricity to reach the AC side
of the inverter.

Anti-islanding

The integrated anti-islanding device switches off the solar
power inverter when the grid fails.

Temperature control

The convection cooling system provides optimal heat dis-
sipation.

An internal temperature controller reduces the output power
at ambient temperatures in the upper operating range. The
solar power inverter is switched off when the ambient tem-
perature exceeds the operating temperature range.

DC voltages

The DC input voltages mentioned in this section are pro-
vided in chapter “15. Technical data”, p. 56.

The maximum input voltage must never be exceed.
Measure the input voltage and use an overvoltage protec-
tion device on the DC side to prevent higher voltages from
reaching the inverter. The maximum open-circuit voltage
occurs at the lowest assumed temperature. More exact
information on temperature dependency is provided in the
PV module data sheet.

The feed-in voltage range of the solar power inverter
defines the range of input voltages over which the solar
power inverter will feed electricity into the grid.

The MPP input voltage range at full power of the solar
power inverter defines the range of input voltages over
which the MPP tracker is activated.

6.2  Functions for influencing the operating
behavior

A detailed description of the functions is provided in chapter
“10. Settings”, p. 39.

e Active power control
e Reactive power control
e Insulation and grounding monitoring

e Extended MPP tracking in the case of partial shadowing
of the PV modules

6.3  Fixed settings for reduction of active
power and reactive power

The settings for reduction of active power and/or reactive
power can be configured during initial commissioning. After
completion of initial commissioning the values can only be
changed using a PIN.

6.4 Balancing of asymmetrical grid loads

If an asymmetrical grid load above the permitted limits (e.g.,
> 4.6 kW for Germany) can occur in the event of a phase
failure, the solar power inverter may be operated only in
combination with a SOLIVIA Gateway M1 G2. The Gateway
controls the feed-in so that an impermissible asymmetrical
grid load cannot occur.

The asymmetrical grid load balancing can be activated dur-
ing the initial commissioning.

After completion of initial commissioning, the function can
only be changed using a PIN.

For a detailed description, see chapter “7.1 Planning the
installation”, p. 19.

6.5 Data analysis and communication

The solar power inverter is controlled by microcontrollers
that also implement the interface communication, the moni-
toring of the values and the display messages.

The solar power inverter acquires and saves various data
values that can be directly shown on the display or sent to a
PC and displayed there.

Production information

Production information is available for the actual day, week,
month, etc. The production information is saved each
month.

Saving the configuration settings

The configuration settings of the solar power inverter can be
exchanged between solar power inverters of the same type
by using a USB stick.

Warning and failure messages

Every warning or failure message is stored with a time-
stamp in the solar power inverter. The messages are stored
in the event log or in the internal log, depending on the
cause of the failure.

Operation and installation manual for SOLIVIA 2.5/3.0/3.3/3.6 EU G4 TR
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Reports

Reports can be read on the display and also stored on a

USB stick. The reports contain information on production,
events, settings and internal logs. For LVD grids, the last
five failures are stored together with the settings.

6.6 Characteristic curves

Efficiency curves

SOLIVIA2.5 EU G4 TR

SOLIVIA3.0 EU G4 TR
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7. Installation

7.

71

71

Installation

Planning the installation

A General instructions

NOTE

If you want to use several of the solar
power inverters described in this manual in
one and the same phase

Always use the mounting plate supplied with the solar
power inverter.

First mount the solar power inverter on the wall and
then establish the electrical connections.

Possible noise emissions can be irritating when the
device is used in living areas. Avoid installing the device
in living areas for this reason.

Mount the solar power inverter so that the LEDs and
display can be easily seen. Pay attention to the reading
angle and installation height.

Mount the solar power inverter on a fireproof wall.

Mount the solar power inverter on a non-resonating
wall.

Check that the wall is capable of carrying the heavy
weight of the device.

Use dowels and screws for the installation that are suit-
able for the wall material and the heavy weight.

Mount the solar power inverter vertically, see Fig. 7.1.

h Vv

Fig. 7.1.: Mounting alignment

7.1.2

>

>

>

Ambient conditions

The solar power inverter has an IP65 degree of pro-
tection and can be installed indoors and in protected
outdoor areas.

Note the Operating temperature range at full power
without derating and the maximum operating tem-
perature range.

When the first operating temperature range is ex-
ceeded, the solar power inverter reduces the amount of
power generated. When the maximum operating tem-
perature range is exceeded, the solar power inverter
switches off.

— Be sure to adhere to the specified minimum clear-
ances to walls and other solar power inverters
when installing the device (see Fig. 7.2.).

— Install multiple solar power inverters next to each
other.

— Avoid direct sunlight.

— Ensure an adequate circulation of air. .

LLLLLLLL L
€
o
o
Tel
A
>10cmp ¢>10 cm
£
o
o
'el
A

[
gl
gl
o

1 ¢>10cm L X

Fig. 7.2.: Mounting clearances for correct convection

Avoid heavy soiling. Dust can impair the performance of
the device.

Protect the solar power inverter from heavy rain and
snow deposits.
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7. Installation

7.1.3 Consideration of the asymmetrical grid load

The use of a SOLIVIA Gateway M1 G2 is mandatory for
some installation types.

For example, this applies to installations in which several
single-phase solar power inverters feed into one and the

same phase and an impermissible asymmetrical grid load
can occur if a phase fails.

Fig. 7.3 shows an example of such an installation for Ger-
many. In Germany, the asymmetrical grid load must not
exceed 4.6 kW.

The three-phase solar power inverter SOLIVIA 11 is unprob-
lematic, because it controls the feed-in internally and always
distributes the fed-in power evenly among all three phases.

The situation is different for the single-phase solar power
inverters. If the phase fails, an asymmetrical grid load
greater than 4.6 kW can occur.

In this case, the Gateway controls the feed-in via the RS485
interface and ensures that an impermissible asymmetrical
grid load cannot occur.

If a Gateway is used to balance asymmetrical grid loads,

you must activate the "asymmetrical grid load balancing"

function on each single-phase solar power inverter during
the initial commissioning.

If the RS485 connection between the Gateway and a
single-phase solar power inverter is interrupted, the function
switches off the solar power inverter after a specified time
for safety.

20
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7. Installation

5 ~ | i ~ | ~ | ~ |
LE'_:@I ; : i ; i E Gateway
! : : N ! : 5 M1 G2
Termination | SOLIVIA5.0 ! | SOLIVIA36 I SOLIVIA36 | ! SOLIVIA 11 :
resisitor | N PE ! ' L NPE % L NPE ¢ ' L1L2L3 N PE !
- G--0--07--- 1= G-- -0 == d1-- G- -0 - B o AaRE LR I e
kWh kWh KWh
L1
L2
L3
N
PE

Fig. 7.3.: Example of multiple solar power inverters connected in one phase
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7.2 Mechanical installation

7.21 Mounting plate

'i Danger of injury due to heavy weight

The solar power inverter is heavy (see “15.

Technical data”, p. 56). Incorrect handling can

lead to injuries.

» The solar power inverter must always
be lifted by at least two people. Or use
an appropriate lifting device, e.g., a
crane.

Materials and tools required
Supplied in the scope of delivery:

= Mounting plate

= 2 mounting nuts and washers for fastening the solar
power inverter to the mounting plate

The following items are also required:

= Screws (& 6 mm) + dowels for fastening the mounting
plate to the wall. At least 4 screws are required.

= Drill and drill bits suitable for the wall material and size
of the dowels.

= Screwdriver or open-ended wrench matching the

SCrews.
* L
—HS A | AL
| 6,5
|
B i
© s
|
88
N I
\
| | ||
] 68 | B In
\
Aa 8 | A
o] i
8 e | )
QI C 150 ¢
319,5
410+ 0,5
Fig. 7.4.: Dimensioned drawing of the mounting plate

1. Fasten the mounting plate to the wall using at least 4
screws (& 6 mm) and appropriate dowels. Use the 4
holes A or the 4 holes B for the 4 screws (see Fig. 7.4).
You can use the mounting plate as a template for mark-
ing the positions of the holes to be drilled.

2. Screw the screws tightly into the wall.

3. Hang the solar power inverter on the mounting plate,
see Fig. 7.5.

Fig. 7.5.: Hanging the solar power inverter on the mount-

ing plate

4. Secure the solar power inverter to the mounting plate
by fitting the washers and mounting nuts on the stud
bolts and then tightening (see Fig. 7.4, item C). (The
stud bolts are also used for connecting the grounding
cable to the solar power inverter.)

5. Check the mechanical installation.

M Mechanical installation of the solar power inverter is
now finished.
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7. Installation

7.3 Electrical installation

A\ DANGER
'i Danger of death or severe injuries from

dangerous voltage
» Switch off the AC cable to be free of
7.3.1  Connecting the grid

voltage before removing or inserting the
AC connector.

General instructions

The solar power inverter is connected to the grid using the
AC plug. The AC plug has a locking mechanism to prevent it
from being unintentionally disconnected. The locking mech-
anism can be released on the AC plug using a screwdriver.

Use a flexible 3-wire cable (L, N, PE) with a conductor
cross-section from 2.5 to 4.0 mm? (coefficient k=1).

Observe the required grid impedance at the grid connection
point (cable length, conductor cross-section).

Select the cable length and conductor cross-section so that
the conductor temperature and cable losses are as small

as possible. In some countries (e.g., France and Germany)
specific requirements for the system installation must be
satisfied (UTE C15-712-1, VDE 0100 712). These require-
ments specify the minimum cable cross-section and the
protective measures required to prevent overheating due to
high voltages. Always adhere to the specific requirements of
your country.

The energy meter must be installed between the solar
power inverter and the grid feed-in point. Observe the direc-
tives of your local electricity supplier when doing this.

The following table shows the maximum permissible trigger
current for the automatic circuit breaker (type B).

Solar power inverter Max. permissible trigger current

25EUG4 TR 20.0A
3.0EUG4 TR
3.3EUG4 TR
3.6 EUG4 TR 25.0A

The AC and DC sides of the solar power inverter are gal-
vanically isolated. This makes it impossible for DC electricity
to reach the AC side of the inverter, i.e., a type A residual
current device is sufficient. We recommend using a 20 A
residual current device. However, be sure to always adhere
to the specific regulations applicable in your country.

The typical leakage current is less than 3.5 mA.

NOTE
The rated value of the secondary short-

circuit current at the grid connection point to
the public power grid increases due to the

To protect the user and the system, install the required

safety and protection devices (e.g., automatic circuit

rated current of the connected solar power
inverter.
breaker and/or overvoltage protection devices).

A special kit for France is available from Delta. This kit
contains all components required for satisfying the require-
ments specified in UTE C15-712-1. (“16.2 Order numbers”,
p. 60).

Materials and tools required

Supplied in the scope of delivery:

= Round plug, type Wieland RST25i3s
Not supplied in the scope of delivery:

= Flexible 3-wire cable (L, N, PE) with a conductor cross-
section from 2.5 mm? to 4 mm?Z.

= Cable strain-relief

= An additional securing washer is required to connect
the ground cable to the solar power inverter (see Fig.
7.4, item C).
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Connecting the cable and the AC plug

1. Remove the cable sheath as shown and remove 10 mm
of insulation from each conductor.

NOTE
Observe the correct polarity of the
@ round plug. An incorrect arrangement
can destroy the solar power inverter.

_ 525mm (PE: 57,5 mm)

10mm_ [
o _ » Screw the cable housing @ onto the socket insert ®
and then screw the nut @ onto the cable housing.
1.
2. Putaferrule on the end of each conductor. —

|_ql I - D
‘—'J' 1
—¢ {

3. Connect the cable to the AC plug as described below.

® @ @

» Unscrew the nut @ from the cable housing @ and then

remove the cable housing from the socket insert ®. > Insert the AC plug into the AC socket @ on the solar

power inverter until the AC plug locks into place.

@

» Slide the cable conductors into the connections in the
pin insert and screw tight. Observe the correct phase
sequence when doing this.
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7.3.2

A\ DANGER
'i Danger of death or severe injuries from

Connecting PV modules

dangerous voltage

Dangerous voltages can be present at the

DC connections of the solar power inverter.

» Never disconnect the PV modules when
the solar power inverter is under load.
First switch off the grid connection so
that the solar power inverter cannot
feed energy into the grid. Then open the
DC disconnector.

» Secure the DC connections against be-
ing touched.

NOTE
To ensure protection conforming to IP65 all

unused connections and interfaces must

be closed using the covers on the solar
power inverter.

General instructions

Check the polarity of the DC voltage at the DC connections

before connecting the photovoltaic system.

The PV module strings are connected to the DC connec-
tions, with the negative DC pole connected to DC MINUS
and the positive DC pole connected to DC PLUS. The con-
nections are coded to prevent incorrect polarity.

The maximum input voltage of the solar power inverter is
600 V when feeding the grid. The maximum current load at
each DC connection is 29 A.

The solar power inverter can be grounded at either the DC
plus side or the DC minus side. The DC side of the solar
power inverter has an insulation and grounding monitor. The
monitoring can be configured in the 230 Grounding menu,
see “10.5.2 Insulation and grounding monitoring”, p. 44.

The solar power inverter has an integrated DC disconnec-
tor.

Tools and devices required
Not supplied in the scope of delivery:
= Single-wire cable for DC connection.

The ground connection must be installed in the immediate
vicinity of the solar power inverter. We recommend using
the "Grounding Set A Solar" grounding kit from Delta.

Grounding kit Delta part number

Grounding Set A Solar EOE990000275

= Cable coupling types for the DC connections to the
inverter.

The DC+ connection of the solar power inverter is a plug,
the DC— connection is a socket.

§ |28 (25§ 8% |3
5 |2® |°% 0 @ £
) 5, CcQ o< 5 EN
c o = % c
g o S ge .
8 |2 g 88 |3
o © ° ] o
[a] o c £
S 8
[=)
mm? AWG |mm
3-6 32.0010P0001-UR
1,5/2,5 14
5,5-9 32.0012P0001-UR
DC+ Socket
476 10 3-6 32.0014P0001-UR
5,5-9 32.0016P0001-UR
3-6 32.0011P0001-UR
1,5/12,5 14
De Pl 5,5-9 32.0013P0001-UR
o e o 30 32.0015P0001-UR
5,5-9 32.0017P0001-UR

= UTE kit according to the current French standard UTE
C 15-712-1

The Multi-Contact UTE Kit is designed to conform to the
latest French standard UTE C 15-712-1. It contains 8 DC
measuring elements, a mounting tool and an additional
signal-flash drive. This kit allow you to conform to the DC
protection and signal requirements specified in UTE C
15-712-1.

Multi-contact UTE kit

Multi-contact UTE kit for SOLIVIA EU Solar
Inverter

Delta part number
EOE90000341

7.3.3 RS485 interface (EIA485)

NOTE
To ensure protection conforming to IP65 all

unused connections and interfaces must
be closed using the covers on the solar
power inverter.

Only the cables described below may be
used. Standard cables are not permitted.

One or more solar power inverters can be connected to
a monitoring system via the RS485 interfaces. The two
RS485 interfaces are internally wired 1:1. Each RS485
interface can be used as an input or output.

Pin assignments

5

Assignment
Reserved
Reserved
Reserved
GND
Reserved
Reserved
X A

RX B

oo |~|o|o| s |w|No]| =
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Connection of a single solar power inverter

RS485 connection cable Delta part number

~
p— Unbenutzte
Iﬁil |_—" Anschliisse
. ! abdecken
RS485

Fir Kabelspezifizierung
Delta Support kontaktieren

Datenlogger

Cable for connecting solar power invert-
ers

Push/Pull cable from Harting, IP67, one side
with a blue cable manager, the other side
with a white cable manager

1.5m 3081186300
3.0m 3081186500
5.0m 3081186600
10.0 m 3081186200
20.0 m 3081186400

Connecting cable from the solar power
inverter to the monitoring gateway device

e.g., Solivia Basic Gateway, Solarlog or
Meteocontrol WEB’logger

Contact Delta
support

Outdoor cable, IP65, with Harting RJ45
PushPull and RJ12 plugs

Fig. 7.6.: Connection of a single solar power inverter to a data

logger via RS485

The RS485 ID can be set during the commissioning (see
Fig. 7.1) or later (see “10.2.6 RS485 (EIA485)”, p. 41).

Connection of multiple solar power inverters

P 5E o

Kabel 308116x00 Kabel 308116x00

] Abschlusswiderstand

Fir Kabelspezifizierung
Delta Support kontaktieren

Datenlogger

100 ...140Q, 0,25 W
Connection of multiple solar power inverters to a data
logger via RS485

Fig. 7.7.:

When multiple solar power inverters are connected to a
monitoring system via RS485, a termination resistor must
be connected to the last solar power inverter of the bus, see
Fig. 7.7.

The termination resistor must be connected to pin 7 (TX_A)
and pin 8 (RX_B).

If you wish to make the cables yourself, then you must use
cable managers from Harting (IP67-Push/Pull system cable
RJ45).

We recommend using a blue cable manager on one side
and a white cable manager on the other side.

Harting part num-
ber

Cable manager

RJI IP67 data plug PushPull 8-pin white 09 45 145 1500

RJI IP67 data plug PushPull 8-pin blue 09 45 145 1510

HARTING Deutschland GmbH & Co. KG (PF 2451,
D-32381 Minden, www.harting.com)
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8. Commissioning

8.1 Before you start

The solar power inverter must be correctly installed, see “7.
Installation®, p. 19.

Information on operating the display is provided in “5.4 Dis-
play and buttons®, p. 11.

After the device has been started for the first time and the
automatic self-test has been completed, you are guided
step-by-step through the initial commissioning procedure.

8.2 Selection of the correct initial commission-
ing procedure

The initial commissioning procedure depends on the follow-
ing criteria:

e |s the solar power inverter to be newly set up from the
very beginning? In this case the decisive factor is the
type of grid to which the solar power inverter is con-
nected.

e Should the solar power inverter be set up with the same
settings as another identical solar power inverter?

e |s the solar power inverter a replacement device for
another identical solar power inverter?

The following table should make the selection of the correct
initial commissioning procedure easier.

Task

Relevant initial commis-
sioning procedure

The solar power inverter is to be set
up from the very beginning and the

grid to which the solar power inverter

is connected is shown in the follow-

ing list:
BE

BUL

cz

DE VDE

ES 51/48Hz
ES 51/49Hz
FR

FRISL. 60Hz

GR CONTINENT

GR ISLAND

IT 50/49Hz
IT 51/49Hz
NL

PT

ROM

SLK

SLN

UK G59

Belgium
Bulgaria
Czech Republic

Germany as per
VDE 0126

Spain 51/48 Hz
Spain 51/49 Hz
France

French Islands
with 60 Hz

Greece /
Continent
(49.5/50.5 Hz)

Greece / Islands
(47.5/51 Hz)

Italy 50/49 Hz
Italy 51/49 Hz
Netherlands
Portugal
Rumania
Slovakia
Slovenia

United Kingdom

“8.3 Standard initial com-
missioning*“, p. 28

The solar power inverter is to be set

up from the very beginning and is con-

nected to an LVD grid.

“8.4 Standard commis-
sioning forLVD grids®, p. 30

DE LVD Germany as per
VDE AR N 4105
DK LVD Denmark as per
VDE AR N 4105

The solar power inverter is to be set

up with the same settings as another

identical solar power inverter.

“8.5 Commissioning by
loading the settings from
another solar power
inverter, p. 33

The solar power inverter is a replace-
ment device for another identical solar

power inverter.

“8.6 Commissioning after
replacing a solar power
inverter®, p. 35

The solar power inverter is to be set
up from the very beginning and the

grid to which the solar power inverter

is connected is not shown in the list

above.

You can set up a specific
grid. Please contact Delta
Support by telephone.
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8.3 Standard initial commissioning

3.1 Brief overview of the commissioning steps

Set the display language
Select the grid
Set the MPP tracking

8.

>

>

>

» Set the power limitation (optional)

» Set the asymmetrical grid load balancing (optional)
» Set the date and time formats

» Set the date and time

>

Set up the RS485 communication

8.3.2 Detailed description of the commissioning
steps

1. Check all connections and cables for damage and cor-
rect seating. Correct the installation if necessary.

2. Switch on the DC disconnector.
— The startup process of the solar power inverter
begins.

After the startup process and the automatic self-test,
the initial commissioning procedure of the solar power
inverter starts and the Installation menu is displayed.

3. Select a language for the display.

Installation

»Language: German
continue

Configurable parameters

Display text Designation Description

Language Language The display language.

Czech | Danish | Dutch | Eng-
lish | French | German | Ital-
ian | Portuguese | Romanian |
Slovak | Slovenian | Spanish

4. Select Continue and press the [2].

Installation
Language: German
>continue

— The Load USB data menu is displayed.

5. Inthe Load USB data menu, select the option No to
perform manual commissioning.

Load USB data
Yes

— The Grid selection menu is displayed.

Select a grid.

Grid selection

»Grid: DE VDE
continue

Grids available for standard commissioning

Display text Description

BE Belgium

BUL Bulgaria

cz Czech Republic

DE VDE Germany as per VDE 0126
ES 51/48Hz Spain 51/48 Hz

ES 51/49Hz Spain 51/49 Hz

FR France

FR ISL. 6@Hz French Islands with 60 Hz

GR CONTINENT Greece / Continent (49.5/50.5 Hz)
GR ISLAND Greece / Islands (47.5/51 Hz)
IT 50/49Hz Italy 50/49 Hz

IT 51/49Hz Italy 51/49 Hz

NL Netherlands

PT Portugal

ROM Rumania

SLK Slovakia

SLN Slovenia

UK G59 United Kingdom

NOTE

» If you set the grid as "IT 50/49Hz"
@ or "IT 50/49Hz", then you must
perform an autotest after commis-

sioning, see “12.7 Autotest for Italy*,
p. 52.

Select Continue and press the [] button.

Grid selection
Grid: DE VDE
»continue

— The DC settings menu is displayed. This setting
cannot be changed, because this solar power
inverter only has a single MPP tracker.

Select Continue and press the =] button.

DC settings
MPPT: PV1
»continue

— The Locked power limit menu is displayed.

If necessary, set power limits for active power and reac-
tive power.

Locked power limit
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8. Commissioning

Configurable parameters 12. Select Continue and press the (=] button.
Display text Designation Description Power balancing
Pmax Maximum active The maximum active EENEEEEEEE 0ff
power power that can be fed L X SEUEE
into the grid. The value >continue
issetinkw. | === ===-=-=-=---=-=------
Smax Maximum appar- The maximum apparent L
ent power power that can be fed — The Format menu is displayed.
into the grid. The value 13. Define the date and time formats.
is set in kVA.
Format
NOTE bbb bbbl bl
- »Date: DD.MM.YYYY
» If you set a power limit then you Timak 12h
@ must also fill out the label stating
"The power of the product has been Configurable parameters
reduced ..." and apply this label to Display text Designation  Description
the front of the solar power |.nverter. Date Date format DD.MM.YYYY
Use a waterproof pen for filling out DD/MM/YYYY
this information. DD-MM-YYYY
MM.DD.YYYY
MM/DD/YYYY
NOTE MM-DD-YYYY
After commissioning, the set power YYYY MM.DD
@ limitation is displayed in menu 131 YYYY/MM/DD
View grid setup (value MaxPower). YYYY-MM-DD
Time Time format 12h | 24h
NOTE 14. Select Continue and press the [ button.
After finishing the commissioning pro- Format
@ cess, the power limitation is locked. TEmEE 24h
» To change the power limitation after B e
commissioning, a PIN is needed. |
10. Select Continue and press the (2] button. — The Date and time menu is displayed.
Locked power limit 15. Set the date and time.
Smaxz === =kVA Date and time
gecnEpnUiciNNNNNNEEEl = mEEEEEEEEEEEEEEEEEEE
"""""""""" »Date: 12.03.2012
— The Power balancing menu is displayed. Time: 10:14:23
11. If you need asymmetrical grid load balancing, set the 16. Select Continue and press the [=] button.
Balancing option to On. -
Date and time
NOTE T1me§ 10:14:23
»>continue
» The G2 Gateway from Deltais | ____ .. ______._.__._
@ required for the balancing of asym-
metrical grid loads. If a G2 Gateway — The RS485 menu is displayed.

is not connected to the RS485

interface, set the Balancing option 17. Set the RS485 ID and the baud rate.

to Offt RS485
Power balancing »ID: 1
___________________ Baud rate: 19200
»Balancing: off
continue Configurable parameters
- Display text Designation Description
Configurable parameters ) RS485 ID 1. 255
Display text Designation Description Baud rate Baud rate 2400 | 4800 | 9600 |
Balancing Balance asym-  Off | On 19200 | 38400, the
metrical grid load standard is 19200
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NOTE

Connecting multiple solar power
@ inverters via RS485
» If multiple solar power inverters are

to be connected via RS485, select
a different ID for each inverter. This
ID will also be used later to identify
each solar power inverter when

loading settings or transferring data.

18. Select Continue and press the [ button.

RS485
Baud rate:
»continue

19200

— The last menu is displayed.

19. Press the [=] button to finish commissioning.

ENTER
to confirm
ESC

for reselection

— The solar power inverter is restarted.

4| Commissioning is now finished.

8.4

8.4
>
| 2
>
>
>
>
|
>
>

Standard commissioning for LVD grids

.1 Brief overview of the commissioning steps

Set the display language

Select the grid

Set up the grid and system protection (NA protection)
Set the MPP tracking

Set the power limitation (optional)

Set the asymmetrical grid load balancing (optional)
Set the date and time formats

Set the date and time

Set up the RS485 communication

8.4.2 Detailed description of the commissioning

steps

Check all connections and cables for damage and cor-
rect seating. Correct the installation if necessary.

Switch on the DC disconnector.

— The startup process of the solar power inverter
begins.

After the startup process and the automatic self-test,
the initial commissioning procedure of the inverter starts
and the Installation menu is displayed.

Select a language for the display.

Installation

»Language: German
continue

Configurable parameters

Display text Designation Description

Language Language The display language
Czech | Danish | Dutch | Eng-
lish | French | German | Ital-

ian | Portuguese | Romanian |
Slovak | Slovenian | Spanish

Select Continue and press the [=] button.

Installation
Language: German
»continue

— The Load USB data menu is displayed.

In the Load USB data menu, select the option No to
perform manual commissioning.

Load USB data
Yes

— The Grid selection menu is displayed.
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10.

Select an LVD grid.

Grid selection

»Grid:
continue

LVD grids available for commissioning

DE LVD Germany as per VDE AR N 4105

DK LVD Denmark as per VDE AR N 4105

Select Continue and press the =] button.

Grid selection
Grid:
»>continue

DE LVD

— The PDD settings menu (grid and system protec-
tion, NA protection) is displayed.

Select a PDD option.

PDD settings

>PDD: Standard
continue

The PDD settings menu offers three options:

Option Description

Standard Loads the settings specified by the rel-
evant standards.

OFF The NA protection is switched off.

USER The parameters can be manually set
within the limits defined in the relevant
standards.

"USER" option

You can set the following parameters:

Configurable parameters

Display text Designation Description

Umax Voltage increase
protection U>

253 ... 264 V (corresponds
to 110 ... 115%)

As defined in the standard VDE AR N 4105, only

the voltage increase protection U> can be set. U> is
conceived as a 10-minute mean value protection, to
avoid exceeding the limit value defined in the standard
DIN EN 50160 (power monitoring).

Select Continue and press the (=] button.

PDD settings
U>:
»continue

— The DC settings menu is displayed. This setting
cannot be changed, because this solar power
inverter only has a single MPP tracker.

Select Continue and press the (=] button.

DC settings
MPPT:
»continue

1.

12.

— The Locked power limit menu is displayed.

If necessary, set power limits for active power and reac-
tive power.

Locked power limit

Configurable parameters

Display text Designation Description
Pmax Maximum active The maximum active
power power that can be fed
into the grid. The value
is set in kW.
Smax Maximum appar- The maximum apparent

ent power power that can be fed
into the grid. The value

is set in kVA.

» If you set a power limit then you
must also fill out the label stating
"The power of the product has been
reduced ..." and apply this label to
the front of the solar power inverter.
Use a waterproof pen for filling out
this information.

NOTE

NOTE

Select Continue and press the (] button.

After commissioning, the set power
limitation is displayed in menu 131
View grid setup (value MaxPower).

After finishing the commissioning pro-

cess, the power limitation is locked.

» To change the power limitation after
commissioning, a PIN is needed.

— The Power balancing menu is displayed.

. If you need asymmetrical grid load balancing, set the

Balancing option to On.

Power balancing

>Balancing:
continue

Configurable parameters
Display text Designation

Balancing Balance asym-
metrical grid load

Description
Off | On.

NOTE

» See chapter “7.1 Planning the
installation®, p. 19 for a description of
the "asymmetrical grid load balanc-
ing" function.
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14. Select Continue and press the [2] button.

15.

16.

17.

18.

19.

Power balancing
Balancing: off
>continue

— The Format menu is displayed.

Define the date and time formats.

Format

»Date: DD.MM.YYYY
Time: 12h

Configurable parameters

Display text Designation

Description

Date Date format

DD.MM.YYYY
DD/MM/YYYY
DD-MM-YYYY

MM.DD.YYYY
MM/DD/YYYY
MM-DD-YYYY

YYYY.MM.DD
YYYY/MM/DD
YYYY-MM-DD

Time Time format

12h | 24h

Select Continue and press the =] button.

Format
Time: 24h
»>continue

— The Date and time menu is displayed.

Set the date and time.

Date and time

»Date: 12.03.2012
Time: 10:14:23

Select Continue and press the [=] button.

Date and time
Time: 10:14:23
»continue

— The RS485 menu is displayed.
Set the RS485 ID and the baud rate. Switch on the

termination resistor if required.

ID: il
Baud rate: 19200

Configurable parameters

Display text Designation Description
ID RS485 ID 1..255
Baud rate Baud rate 2400 | 4800 | 9600 |

19200 | 38400, the
standard is 19200

NOTE

Connecting multiple solar power
@ inverters via RS485
» If multiple solar power inverters are

to be connected via RS485, select
a different ID for each inverter. This
ID will also be used later to identify
each solar power inverter when
loading settings or transferring data.

20. Select Continue and press the [=] button.

RS485
Baud rate: 19200
»continue

— The last menu is displayed.

21. Press the [=2] button to finish commissioning.

ENTER
to confirm
ESC
for reselection

— The solar power inverter is restarted.

4| Commissioning is now finished.
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8.5 Commissioning by loading the settings
from another solar power inverter
ATTENTION

The data is loaded via the USB interface.
Using a USB stick reduces the degree of
protection.

NOTE

The STUP_###.CFG file must be in the
main directory of the USB stick. The ###
characters represent the RS485 ID of the
solar power inverter from which the data is
to be loaded, for example "001".

8.5.

>
>

1 Brief overview of the commissioning steps

Set the display language
Load the data from a USB stick

After loading you can decide whether or not to edit the
data. In this case, the commissioning steps are the same
as those for the standard commissioning (depending on the
grid).

The commissioning process is shorter if you adopt the data
without making changes:

>
>

8.5.

Set the date and time

Set up the RS485 communication

2 Detailed description of the commissioning
steps

Save the settings from the other solar power inverter if
you have not already done this, see “11.4 Saving set-
tings*®, p. 46.

Check all connections and cables for damage and cor-
rect seating. Correct the installation if necessary.

Switch on the DC disconnector.
— The startup process of the solar power inverter
begins.

After the startup process and the automatic self-test,
the initial commissioning procedure of the solar power
inverter starts and the Installation menu is displayed.

Select a language for the display.

Installation

»lLanguage: German

continue

Configurable parameters

Display text Designation Description

Language Language The display language.

Czech | Danish | Dutch | Eng-
lish | French | German | Ital-
ian | Portuguese | Romanian |
Slovak | Slovenian | Spanish

Select Continue and press the =] button.

Installation
Language: German
»continue

— The Load USB data menu is displayed.

In the Load USB data menu, select the option Yes to
load data from the USB stick.

Load USB data

— The next Load USB data menu is displayed.

In the Load USB data menu, select the Load settings
option.

Load USB data

»>Load settings
Load swap data

— The next Load USB data menu is displayed.

Insert the USB stick into the USB socket underneath
the solar power inverter and press the (=] button.

Load USB data

Insert USB Pendrive
and press Enter

— The Select RS485 ID menu is displayed.

Select the RS485 ID of the solar power inverter from
which the data is to be loaded.

Select RS485 ID

»ID:
continue

10. Press the 2] button.

— Loading of the data begins.

A message is displayed when the loading process
is successful.

Load data

Successful
Press ENTER
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11. Press the [J) button.

NOTE

If a power limit was set at the solar
power inverter from which the data
was loaded, the following message
appears:

The power of the
inverter is
limited to:

W

» If you set a power limit, then you
must also fill out the label stating
"The power of the product has been
reduced ..." and apply this label to
the front of the solar power inverter.
Use a waterproof pen for filling out
this information.

NOTE

If the asymmetrical grid load balancing
was activated on the solar power in-
verter from which the data was loaded,
the following message appears:

Power balancing

is activated

— The Edit Loaded Data menu is displayed.
12. Select No and press the (=] button.

>No
Yes

Edit Loaded Data

— The Date and time menu is displayed.

NOTE

Select Yes if you wish to edit the load-
ed data. Commissioning then proceeds
in the same manner as the standard
commissioning procedure (depending
on the selected grid). The loaded data
is then shown in the individual menus
and not the default values.

13. Set the date and time.

14.

Date and time

12.03.2012
10:14:23

Select Continue and press the (=] button.

Time:
»continue

Date and time

10:14:23

16.

17.

— The RS485 menu is displayed.

15. Set the RS485 ID and the baud rate. Switch on the
termination resistor if required.

RS485
1J0)3 1
Baud rate: 19200
Configurable parameters
Display text Designation Description
ID RS485 ID 1..255
Baud rate Baud rate 2400 | 4800 | 9600 |

19200 | 38400, the
standard is 19200

NOTE

Connecting multiple solar inverters

via RS485

» If multiple solar power inverters are
to be connected via RS485, select
a different ID for each inverter. This
ID will also be used later to identify
each solar power inverter when
loading settings or transferring data.

Select Continue and press the [=] button.
RS485
Baud rate: 19200

»continue

— The last menu is displayed.

Press the [=2] button to finish commissioning.

ENTER

ESC

to confirm

for reselection

— The solar power inverter is restarted.

4| Commissioning is now finished.
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8.6 Commissioning after replacing a solar
power inverter

ATTENTION

In this chapter, the term "swap" means the
replacement of a damaged solar power
inverter with a new device of the same type.

The replacement may only be performed
after consulting Delta Solar Support. The
support team will discuss the correct proce-
dure with you.

ATTENTION

The data is loaded via the USB interface.
Using a USB stick reduces the degree of
protection.

NOTE

The STUP_###.CFG file must be in the
main directory of the USB stick. The ###

characters represent the RS485 ID of the

solar power inverter from which the data is

to be loaded, for example "001".

8.6.1 Brief overview of the commissioning steps

» Set the display language
» Load the data from a USB stick

After loading you can decide whether or not to edit the
data. In this case, the commissioning steps are the same
as those for the standard commissioning (depending on the

grid).

The commissioning process is shorter if you adopt the data
without making changes:

» Set the date and time
» Set up the RS485 communication

8.6.2 Detailed description of the commissioning
steps

1. Save the swap data from the other solar power inverter
if you have not already done this, see “11.6 Saving
swap data“, p. 46.

2. Check all connections and cables for damage and cor-
rect seating. Correct the installation if necessary.

3. Switch on the DC disconnector.
— The startup process of the solar power inverter
begins.

After the startup process and the automatic self-test,
the initial commissioning procedure of the solar power
inverter starts and the Installation menu is displayed.

4. Select a language for the display.

Installation

Language: German
continue

Configurable parameters

Display text Designation Description

Language Language The display language.

Czech | Danish | Dutch | Eng-
lish | French | German | Ital-
ian | Portuguese | Romanian |
Slovak | Slovenian | Spanish

Select Continue and press the =] button.

Installation

»continue
Language: German

— The Load USB data menu is displayed.

In the Load USB data menu, select the option Yes to
load data from the USB stick.

Load USB data

»Yes
No

— The next Load USB data menu is displayed.

In the Load USB data menu, select the Load swap
data option.

Load USB data

>Load swap data
Load settings

— The next Load USB data menu is displayed.

Insert the USB stick into the USB socket underneath
the solar power inverter and press the (=] button.

Load USB data

Insert USB Pendrive
and press Enter

— In the subsequently displayed menu, select the
RS485 ID of the solar power inverter from which
the data is to be loaded.

Select the RS485 ID of the solar power inverter from
which the data is to be loaded.

Select RS485 ID

>ID:
continue

10. Select Continue and press the [2] button.

— Loading of the data begins.

A message is displayed when the loading process
is successful.

Load data

Successful
Press ENTER
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11. Press the [J) button.

NOTE

If a power limit was set at the solar
@ power inverter from which the data
was loaded, the following message

appears:

The power of the
inverter is
limited to:

» If you set a power limit, then you
must also fill out the label stating
"The power of the product has been
reduced ..." and apply this label to
the front of the solar power inverter.
Use a waterproof pen for filling out
this information.

NOTE

If the asymmetrical grid load balancing
@ was activated on the solar power in-
verter from which the data was loaded,

the following message appears:

Power balancing

is activated

— The Edit Loaded Data menu is displayed.
12. Select No and press the (=] button.

Edit Loaded Data

>No
Yes

— The Date and time menu is displayed.

13. Set the date and time.

Date and time

RS485
Baud rate: 19200
»continue

Configurable parameters

Display text Designation Description
1D RS485 ID 1..255
Baud rate Baud rate 2400 | 4800 | 9600 |

19200 | 38400, the
standard is 19200

16. Select Continue and press the [=] button.

RS485
Baud rate: 19200
continue

— The last menu is displayed.

17. Press the [=2) button to finish commissioning.

ENTER
to confirm
ESC
for reselection

— The solar power inverter is restarted.

4| Commissioning is now finished.

8.7 Next steps

» If the solar power inverter is connected to an LVD grid,
the active and reactive power control settings can be
configured, see “10.4 Active and reactive power con-
trol“, p. 41.

» The solar power inverter offers a number of optional
functions, see “10.5 Options settings®, p. 43.

NOTE

On completion of commissioning, save
@ the settings (see “11.4 Saving settings®,
p. 46) and the swap data (see “11.6 Sav-

ing swap data“, p. 46) on a USB stick so
that you can use this information later.

Date: 12.03.2012
Time: 10:14:23

14. Select Continue and press the [2] button.

Date and time
Time: 10:14:23
»continue

— The RS485 menu is displayed.
15. Set the RS485 ID and the baud rate.

NOTE

Since this is a replacement unit, you do
@ not usually need to change the RS485
settings at this point.
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9. Production information

Structure

Sub-menu

Contents and example display

NOTE 411 Actual overview

All production information is provided for orienta-
tion purposes only. The measuring devices and
meters provided by the electricity supply com-

pany are the authoritative source of information
for invoicing.

9.1 Overview

The 400 Production info menu contains current data and
statistics. The information is write-protected and cannot be

edited.

» Select the Production info menu item in the main

menu.

— The 400 Production info menu is displayed.

400 Production info

»Current data
Day statistics

Structure of the 400 Production info menu

Current power and energy generation
for the current day.

Actual operating state (see “12. Diag-
nosis and maintenance”, p. 48)

411 Actual overview
Now: W
Day: _Wh
Normal operation

If there are messages, the list of mes-
sages can be opened by pressing the
button. For a detailed description,
see chapter “12. Diagnosis and main-
tenance”, p. 48.

412 Actual data AC

Displays for: voltage, frequency, cur-
rent, active power P, reactive power
Q, DC feed-in

412 Actual data AC

L1 voltage: Vv
L2 voltage: Vv
L3 voltage: Vv

Sub-menu

Contents

Description

410 Current data

Current data for
power, AC, PV, insu-
lation

“9.2 Actual data”,
p. 37

416 Current data PV

Data for: voltage, current
416 Current data PV

PVl Voltage: ===V
PV1 Current: -.--A

420 Day statistics

430 Week statistics

440 Month statistics

450 Year statistics

460 Total statistics

Statistics for AC, PV
and ISO

“9.3 Other statis-
tics”, p. 38

470 Feed-in settings

Settings for currency
and revenue per kWh

“10.3 Grid freed-
in settings”, p. 41

480 Event journal

List of operating state
messages

“12. Diagnosis
and mainte-
nance”, p. 48

41A Date and time

Shows the actual date and time.

Use the 110 Date and time menu to
set the values, see “10.2.2 Date and
time”, p. 39.

41A Date and time

Date:
Time:

09/14/2011
HgEL5H22

490 7-day statistics

Statistics for the last
seven days in which
the solar power
inverter was in opera-
tion.

“9.3 Other statis-
tics”, p. 38

41B Actual isolation

Data for: maximum and minimum
insulation resistances

41B Actual isolation
R ISO max: _ka
R ISO min: _ka

9.2 Current data

Relevant menu

The actual production data is provided in the menu 410

Current data.

Access

» You access the menu by navigating to Main menu >
Production info > Current data.

— The 410 Current data menu is displayed.

410 Current data

~Current overview
Current data AC
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9.3 Other statistics

Menu

420 Day statistics

430 Week statistics

440 Month statistics

450 Year statistics

460 Total statistics

490 7-day statistics

Example display

420 Day statistics
Day stat. AC

»Day stat. PV
Day stat. ISO

The statistics for day, week, month, year and total produc-
tion time all offer the same type of data.

The 490 7-day statistics menu shows the statistics for the
last seven days over which the solar power inverter was in
operation.

490 7-day statistics
Day: 16.04.2012
>Day: 15.04.2012
Day: 13.04.2012
Structure
Sub-menu Contents
421 Day stat. AC Statistics for: energy, runtime, rev-

431 Week stat. AC enue
441 Month stat. AC
451 Year stat. AC
461 Total stat. AC

Information on configuring the rev-
enue settings is provided in “10.3 Grid
freed-in settings”, p. 41.

421 Day stat. AC

Energy: ----Wh
Runtime: -:--h
Revenue: ==l ==
Displays for:

Af Minimum/maximum frequency
Imax Maximum current

AU Minimum/maximum voltage

Pmax Maximum active power
Qmax  Maximum reactive power
Qmin  Minimum reactive power

421 Day stat. AC
L1 Af: --.--/--.--Hz
L1 Imax: -=.--A
L1 AU: =|=l=}/=1=1=)
422 Day stat. DC Displays for:
432 Week stat. DC
442 Month stat. DC Pmax Maximum power

452 Year stat. DC Imax Maximum current

462 Total stat. DC Umax Maximum voltage
422 Day stat. DC
PV1 Imax: | |o] JA
PV1 Umax: _Vv
PV1 Pmax: W

Contents

Statistics for: maximum/minimum
insulation resistances

Sub-menu

423 Day stat. ISO
433 Week stat. ISO
443 Month stat. ISO
453 Year stat. ISO
463 Total stat. ISO

Pmax Maximum power
Imax Maximum current

423 Day stat. ISO

R ISO max: ----ka
R ISO min: ----ka
Statistics for the last 7 days in which

the solar power inverter was in opera-
tion.

491 ... 497 Day ...

The statistics contain the same infor-
mation as the menus 421, 422 and

423.

491 Day 16.04.2012
Energy: ----Wh
Runtime: -:--h
Revenue: --.--EUR

9.4 Deleting statistics

Description

All statistics can be deleted (except for 410 Actual data).
The procedure is always the same.

1. Navigate to Production info > Feed-in settings >
Delete statistics.

— The 472 Delete statistics menu is displayed.

472 Delete stats.

>Delete day stat.
Delete week stat.

2. Usethe buttons to select the statistic you wish to
delete (e.g., Delete day stat.) and press the (=] button.

— A confirmation query is displayed.

3. Select the option Yes and press the (] button to delete
the statistic.

Delete day stat.
No
>Yes

— A confirmation message is displayed.

Delete day stat.
No

Successful
Press ENTER

M The statistic is deleted.
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10. Settings

10.1 Overview

This chapter describes how to edit the configurable settings.

e Installation settings (“10.2 Installation settings”, p. 39)

e  Grid freed-in settings (“10.3 Grid freed-in settings”, p. 41)

e User settings (only for LVD grids) (“10.4 Active and
reactive power control”, p. 41)

e Options settings (“10.5 Options settings”, p. 43)
e Standard menu (“10.6 Standard menu”, p. 44)

Information on operating the display is provided in “5.4 Dis-
play and buttons”, p. 11.

10.2 Installation settings

Configurable settings

e Display language

e Date, time

e Date format, time format
e Backlighting, contrast

e Grid selection

o RS485 settings

10.2.1 Display language

Description

10.2.2 Date and time

Description EN
Menu: 110 Date and time
Menu access: Main menu > Install settings > Date and
time
Example display: 110 Date and time
Format
>Date: 11/17/2012
Time: 03:15:22pm
Configurable parameters
Display text Designation Description
Date Date Freely configurable according to
the selected date format
Time Time Freely configurable according to

the selected time format

Menu: 100 Install settings

Menu access: Main menu > Install settings
- or -

Press the [E() and [ | buttons at the same
time.

Example display 100 Install settings

RS485
>Language: English
Date and time

Configurable parameters

Display text Designation Description

Language Language The display language.

Czech | Danish | Dutch | English |
French | German | Italian | Portu-

guese | Romanian | Slovak | Slove-

nian | Spanish

10.2.3 Date and time formats

Description

Menu:

111 Format

Menu access:

Main menu > Install settings > Date and
time > Format

Example display:

111 Format
»Date: MM/DD/YYYY
Time: 03:03:25pm

Configurable parameters

Display text

Designation Description

Date

DD.MM.YYYY
DD/MM/YYYY
DD-MM-YYYY

MM.DD.YYYY
MM/DD/YYYY
MM-DD-YYYY

YYYY.MM.DD
YYYY/MM/DD
YYYY-MM-DD

Date format

Time

Time format 12h | 24h
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10.2.4 Backlighting, contrast 4,
Description
Menu: 120 Display settings
Menu access: Main menu > Install settings > Display
settings

Example display: 120 Display settings

>Backlight: Auto
Contrast: 10 5
Configurable parameters
Display text Designation Description
Backlight Display backlightingAuto | On
Auto = The backlighting
switches on when a display
button is pressed.
6.

On = The backlighting is
always switched on.
Contrast Display contrast  5..10

10.2.5 Grid change

A\ ATTENTION

If the selected grid is changed, a completely
new commissioning process is started, see
“8. Commissioning”, p. 27.

» Always first contact the Delta Support
Team before changing the selected
grid!

NOTE

You always require a PIN in order to enter
@ the grid selection mode. You require a new
PIN each time you wish to select a new

grid. You obtain a PIN from the Delta Sup-
port Team on request.

You must provide a key in order to receive a PIN. You will
find the key in the menu 132 Grid change.

1. To display the key, navigate to Main menu > Install
settings > Grid selection> Grid change.

132 Grid change
Grid: DE VDE
Key: HEHAAAHHHHH
PIN:  Confirm

The key consists of 11 numbers and letters.

2. The Delta Support Team will provide you with the four-
digit PIN.

3.  When you have received the PIN, navigate to the menu
132 Grid change and press the [~] button.

— The first digit of the PIN flashes.

Use the buttons to set the first digit and press the
button to proceed to the next digit.

— After entering the full PIN, the word Confirm
flashes.

PIN: 1234 Confirm

Press the [=2] button to confirm the entered PIN.

— The Installation menu is displayed.

Installation

>Language: English
continue

Start the commissioning of the solar power inverter, see
“8. Commissioning”, p. 27.
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10.2.6 RS485 (EIA485)

10.4 Active and reactive power control

Description NOTE
Menu: 140 RS485 This chapter applies only to LVD grids. The
Menu access: Main menu > Install settings > RS485 @ 500 User settings menu is not displayed
Example display: 140 RS485 for all other grids.
~>ID: 1 .
10.4.1 Overview
Baud rate: 19200
The 500 User settings menu provides various functions for
Configurable parameters configuring the active and reactive power control.
Display text Designation Description Function/Mode Description
ID RS485 ID 1..255 Active power control
Baud rate Baud rate 2400 | 4800 | 9600 | 19200 Power reduction For setting the maximum generated active

| 38400, the standard is
19200

NOTE
Connecting multiple solar inverters via

RS485

» Select a different ID for each solar
power inverter.

» A termination resistor must be connect-
ed to the last solar power inverter in the
series (see “10.2.6 RS485 (EIA485),

p. 41).

10.3 Grid freed-in settings

Description
Menu: 470 Feed-in settings
Menu access: Main menu > Production info> Feed-in
settings
Example display: 470 Feed-in settings
»Currency: EUR
EUR / kWh: 0,28

Configurable parameters

Display text Designation Description
Currency Currency No pre-defined values.
EUR / kWh EUR/kWh No pre-defined values. The

amount (EUR) per kWh is
required for the revenue
calculation.

power

For setting the power gradient with respect

to the frequency

Reactive power control

Constant cos @ For setting a fixed value for cos ¢ (induc-
tive or capacitive)

For setting a value of cos ¢ (inductive or
capacitive) depending on the active power
ratio P/P_

Power/Frequency

cos ¢ (P)

10.4.2 Active power control

10.4.2.1 Overview

Mode Description
Power reduction For reducing the maximum power gener-
ated

Power/Frequency For setting the power gradient with respect

to the frequency

10.4.2.2 Power reduction

Description
This mode is available for LVD grids.

The maximum permissible active power can be set as
a percentage of the maximum power of the solar power
inverter.

NOTE
If a power limit was set during commission-

ing, the percent value relates to the maxi-
Menu:

511 Power reduction

mum active power that was set.
Menu access:

Main menu > User settings > Active
PwCtrl > Power reduction

Example display: 511 Power reduction

>Max power: 100%
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Configurable parameters

Display text Designation Description

Max power Maximum active  Limits the active power to
power the set value.

10.4.2.3 Power/Frequency

Description

This function is available for LVD grids.
The power can be set to be a function of the frequency.

The operating behavior of the solar power inverter dif-
fers depending on whether it is connected to an LVD grid
(according to German regulations).

Operating behavior in LVD grids

Pm

fstart fstop f (Hz)

Variant 1 (black arrow): The actual frequency lies between f

Start
and fsmp

When the actual frequency is greater than f,_, the value of the

actual power P_ is automatically saved and power reduction starts.

The power reduction is adjusted according to the gradient (black
arrow) as long as the actual frequency remains above f_, and

below fsmp.

Variant 2 (orange arrow): Actual frequency lies above f,

The power reduction is switched off when the actual frequency lies
above fsmp. It remains switched off until the actual frequency drops
below f,_.. When the actual frequency drops below f_ ., the power
reduction is started again but is limited to the stored value P .
When the actual power reduction increases above P, the rate of

increase is automatically limited to 10% of P_ per minute.

Menu: 512 Power vs freq

Menu access: Main menu > User settings > Active

PwCtrl > Power vs freq

Example display: 512 Power vs fregq
Gradient: 40%
»Start freq: --.--Hz
Stop fregq: --.--Hz

Configurable parameters

Display text Designation Description

Start freq Start frequency Frequency at which the

power reduction starts.

Value range:
50.00 .. 55.00 Hz

Standard: 50.20 Hz

Display text
Stop freq

Designation
Stop frequency

Description
Frequency at which
the power reduction is
switched off.

Value range:
50.00 .. 55.00 Hz

Standard: 51.50 Hz

Adjustment of the produced
active power in percent
per Hz.

Value range: 0 .. 150%
Standard: 40%

Gradient Gradient

10.4.3 Reactive power control

10.4.3.1 Overview

Mode Description

Cos @ constant For setting a fixed value for cos @ (inductive or
capacitive)

For setting a value of cos ¢ (inductive or
capacitive) depending on the active power
ratio P/P_

Cos phi(P)

All functions are provided in the menu 520 Reactive PwC-
trl

Only one of the modes can be activated.

Access and activation

» You access the menu by navigating to Main menu >
User settings > Reactive PwCtrl.

» Use the Mode parameter to select the mode to be used
for reactive power control or select "disabled" if you do
not wish to use reactive power control.

— The parameters available in the menu are set ac-
cording to the selected mode.
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10.4.3.2 Constant cos ¢

Description
This mode is available for LVD grids.

This mode allows selection of a constant cos ¢.

Configurable parameters

Menu: 520 Reactive PwCtrl
Mode: Fix. cosPhi
Example display: 520 Reactive PwCtrl
>Mode: Fix. cosPhi
Cos phi: ind 0.90
Configurable parameters
Display text Designation Description
Cos phi cos @ Defines cos ¢ to be the set
value.
inductive | capacitive
1..08
10.4.3.3 cos ¢@(P)
Description

This mode is available for LVD grids.

This mode allows cos ¢ to be assigned a power ratio (LV)
PP,

Four combinations of the power ratio value and cos ¢ can
be defined. The values of the power ratio value and cos ¢
are arranged in pairs: cos ¢ "B" belongs to power ratio "B",
cos ¢ "C" belongs to power ratio "C".

The following curve is a configuration example for the val-
ues and the operating behavior resulting from these:

CcoS @ "B" |amaaon
Inductive

50 10p% PP,
Capacitive
cos ¢ "C"

0.8

cos ¢ "D"

= PR‘B'range - PR‘C'range —*
PR"A"=0% PR"B" PR"C" PR"D"=100%

Fig. 11.8.:  Example cos ¢ (P) curve

Menu: 520 Reactive PwCtrl

Mode: Cos phi(P)

Example display: 520 Reactive PwCtrl

D Cos Phi: cap 1.00
>Mode: Cos phi(P)
A Cos Phi: cap 1.00

Display text Designation Description

A cos phi: ind cos @A inductive | capacitive;
1.00 1..08

B cos phi: ind cos¢B inductive | capacitive;
1.00 1..08

B Power ratio  Power ratio B 1...49%

C cos phi: ind cos ¢ C inductive | capacitive;
1.00 1..08

C Power ratio  C power ratio 50 ... 99%

D cos phi: ind cos ¢ D inductive | capacitive;
1.00 1..08

The power ratios A and D are fixed at values of 0% and
100% and cannot be changed. These two values are there-
fore not displayed.

10.5 Options settings

Configurable settings
e Shadowing

e Insulation and grounding monitoring

10.5.1 Shadowing

Description

The "Shadowing" option is an extended MPP tracker. When
the option is switched on, the MPP tracker performs an
additional search at regular intervals.

The MPP tracker then searches for the maximum power
over a wider voltage range.

This option should be switched on if shadows regularly pass
slowly over the PV modules in the course of a day. These
types of moving shadows can be caused by chimneys or
trees, for example. This option has a relatively small effect
in the case of fast-moving shadows, e.g., from passing
clouds.

The option is set depending on the size of the shadowing.

Menu: 210 Shadowing

Menu access: Main menu > Options > Shadowing

Example display: 210 Shadowing
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Configurable parameters

Display text Designation Description

Mode: Mode Deactivated
Extended MPP tracking is
deactivated
High

High shadowing,
time cycle: 0.5 hours

Configurable parameters

Description

ISO Failure
ISO Warning

— GND Failure
— GND Warning
+ GND Failure
+ GND Warning
ISO/GND off

Display text Designation
PV PV monitoring

Medium

Medium shadowing,
time cycle: 2 hours

Low

Low shadowing,
time cycle: 4.5 hours

10.5.2 Insulation and grounding monitoring

Description

The DC side of the solar power inverter has an insulation
and grounding monitor.

The insulation monitoring offers two modes:
e |SO Error
e |SO Warning

If the positive or negative pole of the PV modules must be
grounded to satisfy the requirements of the module manu-
facturer, then this grounding can be monitored. The ground-
ing monitoring has four modes:

e — GND Failure
e — GND Warning
e + GND Failure
e + GND Warning

Before delivery, the solar power inverter is set at the factory
to the ISO Warning (Insulation warning) mode.

Description of the monitoring modes:

Monitoring mode Description

ISO/GND off Monitoring is deactivated.

xxx Failure If an insulation failure occurs, the solar
power inverter is disconnected from
the grid.

xxx Warning If an insulation failure occurs, the solar
power inverter logs and displays the
failure but is not disconnected from
the grid.

Menu: 230 Grounding

Menu access: Main menu > Options > Grounding

Example display: 230 Grounding

10.6 Standard menu

Description

A standard menu can be defined, which is automatically
displayed when the display buttons are not used for a cer-
tain period of time. When the standard menu is displayed,
pressing the [E() button displays the main menu.

The standard menu is set to 411 Actual data at the factory.
This menu shows the actual data and actual operating mes-
sages.

The number must be a valid menu number.

See “16.3 Overview of menu structure”, p. 61 for an overview
of all available menu numbers.

1. Press the [2] button to enter the menu number.
— The first digit flashes.

2. Enter the first digit of the menu number using the (L] 7]
buttons.

— You can only set menu numbers that actually exist.
The name of the associated menu is displayed in
the fourth display row.

3. Once you have set the first digit, press the (=] button.
— The second digit flashes.

4. Enter the second and third digit in the same manner.

5. Press the [2] button.

— The menu corresponding to the entered menu
number is displayed.

800 Standard
Main menu > Standard

800 Standard menu

Menu:
Menu access:
Example display:

~Menu number: 411
411 Actual overview

Configurable parameters

Display text
Menu number

Designation
Menu number

Description
Any valid menu number.
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11. Saving and loading data and set- 11.2.2 Disabling the USB interface
tings 1. Navigate to Main menu > USB features > State.

300 USB features
111 Beforeyoustart = L ...
>State: enabled
Firmware update

Data and settings can be saved and loaded via the USB
interface of the solar power inverter.

2. Press the [2] button. The value enabled flashes.
NOTE 3. Use the [{][]w buttons to change the state to dis-

The swap data can be loaded only during abled.
the installation process.
300 USB features

State: disabled
Firmware update

Information on operating the display is provided in “5.4 Dis-
play and buttons”, p. 11.

The USB interface is disabled by default. It must be 4. Press the (] button to accept the new value.
enabled before use and disabled again after use, see “11.2 . . .
Enabling/disabling the USB interface”, p. 45. M The USB interface is now disabled.

A\ ATTENTION 11.3 Firmware update

The IP 65 degree of protection is no longer The firmware can be updated via the USB interface:
guaranteed when the USB interface protec-
tive cover is removed. NOTE

» Only remove the protective cover when The file containing the firmware data must
necessary. have the name "Image.hex" and must be
» Always use the Micro-USB stick pro- located in the main directory of the USB
vided. The protective cover is designed stick.
to fit over the Micro-USB stick.

Rename the file correctly if necessary! You
will need a PC for this!

11.2 Enabling/disabling the USB interface 1. First enable the USB interface (see “11.2.1 Enabling the

USB interface”, p. 45).
2. Insert the USB stick into the USB interface socket.

The USB interface must be enabled before use.

The USB interface must be disabled again after use.
Navigate to Main menu > USB features > Firmware

11.2.1 Enabling the USB interface update.
1. Navigate to Main menu > USB features > State. 300 USB features
State: disabled
300 USB features >Firmware update
"""""""""" Save settings
>State: disabled
Firmware update 4. Press the 2] button.

— The firmware update starts. A message is displayed
after a successful download (100%).

5. Press the [i() button to confirm.
6. Remove the USB stick.

300 USB features 7. Disable the USB interface (see “11.2.2 Disabling the

------------------- USB interface”, p. 45).
»State: enabled
EEEEEEEENIEEEEE 8. Restart the solar power inverter.

2. Press the [2] button.
— The value disabled flashes.
3. Usethe buttons to change the state to enabled.

M The firmware update is automatically enabled after the
restart.

>

Press the (] button to accept the new value.

M The USB interface is now enabled.
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11.4 Saving settings

The solar power inverter settings can be saved to allow
them to be loaded into another solar power inverter of the
same type that is to be used with the same settings.

The saved settings are:

e Grid settings

e User settings

e Display settings

e Production settings
Save the settings as follows:

1. First enable the USB interface (see “11.2.1 Enabling the
USB interface”, p. 45).

2. Insert the USB stick into the USB interface socket.

Navigate to Main menu > USB features > Save set-
tings.

300 USB features
Firmware update
Save settings
Save swap data

4. Press the [=] button.

— The save process begins. A message is displayed
after saving succeeds (100%).

5. Press the [E() button to confirm.
6. Remove the USB stick.

7. Disable the USB interface (see “11.2.2 Disabling the
USB interface”, p. 45).

11.5 Loading settings

To simplify the setup procedure, the settings from another
solar power inverter of the same type can be loaded and
used in another solar power inverter that is to use the same
settings. Information on saving the settings is provided in
“11.4 Saving settings”, p. 46.

Load the settings as follows:

1. First enable the USB interface (see “11.2.1 Enabling the
USB interface”, p. 45).

2. Insert the USB stick into the USB interface socket.

3. Navigate to Main menu > USB features > Load set-
tings.

300 USB features
Create Reports

»>Load settings
Service

4. Press the [=] button.

— The loading process begins. A message is dis-
played after loading succeeds (100%).

Press the [E() button to confirm.
6. Remove the USB stick.

7. Disable the USB interface (see “11.2.2 Disabling the
USB interface”, p. 45).

11.6 Saving swap data

NOTE
In this chapter, the term "swapping" means

the replacement of a solar power inverter
with a new device of the same type, without
changing the installation parameters, e.g.,
those of the PV modules.

The replacement may only be performed
after consulting Delta Solar Support. The
support team will discuss the correct proce-
dure with you.

The following data is saved:

e Grid settings

e User settings

e Display settings

e Production settings

e RS4851D

e  Statistics

e Date of first installation
Save the swap data as follows:

1. First enable the USB interface (see “11.2.1 Enabling the
USB interface”, p. 45).

2. Insert the USB stick into the USB interface socket.

3. Navigate to Main menu > USB features > Save swap
data.

300 USB features
Save settings
»>Save swap data
Create Reports

4. Press the [ button.

— The save process begins. A message is displayed
after saving succeeds (100%).

5. Press the [E(] button to confirm.
6. Remove the USB stick.

7. Disable the USB interface (see “11.2.2 Disabling the
USB interface”, p. 45).
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11.7 Creating reports

The reports contain the following information:

Firmware/Serial number of the model
Statistics, events, comparison statistics/events
Internal logs

AT reports

MVD/LVD reports

Save the reports as follows:

1.

First enable the USB interface (see “11.2.1 Enabling the
USB interface”, p. 45).

Insert the USB stick into the USB interface socket.

Navigate to Main menu > USB features > Create
Reports.

300 USB features
Save swap data

»Create Reports
Load settings

Press the [2)] button.

— The save process begins. A message is displayed
after saving succeeds (100%).

Press the [E{) button to confirm.
Remove the USB stick.

Disable the USB interface (see “11.2.2 Disabling the
USB interface”, p. 45).

11.8 Service

This function is used for servicing purposes. You will be
notified by Delta Support when this function must be used.
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12. Diagnosis and maintenance

12. Diagnosis and maintenance

12.1 Operating state

12.1.1 Types of operating states

Operating state  Associated influenc-  Grid feed-in
ing factors
Normal operation No factors are present  Yes
that influence the pro-
duction results.
Limited operation  Non-critical factors that  Different
can affect the produc-
tion results but which
are not failures (e.g.,
self-test).
Warning External events or inter- Yes
nal failures are present
- that affect the produc-
Failure tion results. No
Insulation or Problems exist with the  Yes
grounding warn-  insulation or grounding
ing.
Insulation or No

grounding failure.

Table 12.1.: Operating states of the solar power inverter

See chapter ,12.1.2 Factors influencing the operating state®,
p. 48 for a description of the influencing factors.

Grid feed-in is always stopped when the solar power
inverter enters the "Failure" operating state.

12.1.2 Factors influencing the operating state

Different influencing factors are assigned to the individual
operating states. These influencing factors are divided into
the following categories.

Non-critical factors

Non-critical factors are (for example) the self-test or a DC
voltage that is too low due to bad weather. Non-critical fac-
tors are therefore not failures.

Events
Events are usually caused outside the solar power inverter.

Events are divided into external events (e.g., voltage or

frequency errors) and parameter changes occurring via the

buttons or the RS485 interface.

Internal failures

Internal failures are caused from within the solar power
inverter and must be corrected with help of the Delta Sup-
port Team.

Insulation and grounding failures

Insulation and grounding failures are logged and displayed
when the insulation and grounding monitoring is enabled
(see chapter ,5.5.4 RS485 interface (EIA485), p. 16).

12.1.3 Display of the actual operating state

The actual operating state is indicated via LEDs.

A short message is also shown in the fourth line of the 411
Actual overview menu.

Now:
Day:

411 Actual overview

Normal operation

W
_Wh

The 411 Actual overview menu is automatically displayed

when a new message arrives.

Message cat-
egory

LED status

Display text in menu
411

Normal operation

\ L/
—@Z= Operation
/N
O Earth Fault
O Failure

Normal operation

Limited operation

-3@:-Operation
O Earth Fault
O Failure

e.g. Self-test

General warning
messages

—@=Operation
O Earth Fault
O Failure

For external events:
External events

For internal fail-
ures: Warning ###
(3-digit number)

General failure

For external events:

messages O Operation External events
O Earth Fault For internal fail-
\/
e ures: Failure ###
//C)\\ Failure (3-digit number)
Insulation or Insulation

grounding warn-
ing

\ /
—@Z= Operation
o
--@:-Earth Fault

O Failure
Insulation or Insulation
grounding failure O Operation
\ /
~\, v
j/.\: Earth Fault
O Failure

Table 12.2.: Message categories indicated by the LEDs

The software defines which events trigger a warning and
which events trigger a failure.

For problems with the insulation or grounding, you can use
the 230 Grounding menu to define whether a warning

or failure is triggered (see chapter ,10.5.2 Insulation and
grounding monitoring®, p. 44).

12.2 Event journal

12.2.1 Overview

Menu: 480 Event journal
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Main menu > Production info> Event
journal

Menu access:

Example display: 480 Event journal

All events
>Change events
External events

12.2.3 External events menu

Description

Menu:

483 Event journal

Menu access:

Main menu > Production info> Event
journal > External events

The event journal contains the messages relating to the
following events:

e Parameter changes

Changes to all parameters influencing the energy pro-

duction and thus also the revenue.
e External events

Example display:

483 External events
16.04.2012 17:25:36
L1 Islanding

Begin

The external event message has the following structure:

e  Problems with the insulation and grounding 2nd line Date and time when the external event
occurred.
Sub-menu Description 3rd line Short description of the failure (see chap-
481 All events Alist of all parameter changes and ter,12.3 Fault-finding and correction®, p. 49)
external events 4th line Additional information, e.g., "Begin" for the

482 Change events
via the display or via RS485.

A list of parameter changes made

483 External events A list of all external events.

12.2.2 Change events menu

Description

The 482 Change events menu contains a chronological list
of all changes to parameters influencing the energy produc-

tion and thus also the revenue.

Menu: 482 Change events

Main menu > Production info> Event
journal > Change events

Menu access:

occurrence of an event or "End" for the
disappearance of an event.

12.3 Fault-finding and correction

12.3.1 External events / Insulation and grounding

failures

The 411 Actual overview menu shows one of the following
messages:

411 Actual data
L]il

Day: Wh
External events

Example display: 482 Change events

16.04.12 17:25:36 D
Max. power: 100%
Max. power: 90%

The parameter change entry has the following structure:

2nd line Date and time when the external event

occurred.

Source of the change:
D: Display

E: External (RS485)
U: USB interface

S: System

3rd line Name of the changed parameter + previ-

ous value

4th line Name of the changed parameter + new

value

411 Actual data
L]l

Day: Wh
Insulation

1.

To receive a more exact description of the problem,
press the |=) button in the 411 Actual overview menu.

— The External events menu is displayed.

External events
PV1+ Grounding warn
PV1 ISO running warn
PV1 ISO startup warn

The menu contains a list of all active messages re-
lating to external events and insulation/grounding.

Press the (2] button again.

— The 480 Event journal menu containing the de-
tailed message text is displayed (see ,12.2 Event
journal®, p. 48).

480 Event journal

>All events
Change events
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3. Select the entry External events and press the

button.

480 Event journal
Change events
External events

— The 483 External events menu is displayed.

Begin

483 External events
16.04.2012 17:25:36
L1 Islanding

Alternatively, you can also directly open the 483 External
events menu via the "Go to menu" function, see chapter
»9.4.5 “Go to menu” function®, p. 12.

The following table shows the failure messages that can
appear in the 483 External events menu and provides
fault-finding and correction suggestions.

LEDs

Display message

Message description

Fault correction

LEDs Display message

Message description

Fault correction

:\ /i Warning #i##

Internal failure ("Warning" +
three-digit number)

O . » Please contact Delta
'O' Support.
@) Failure #i## Internal failure ("Failure" +
o three-digit number)
:\di » Please contact Delta
TN Support.
L1 Voltage failure AC overvoltage or undervolt-
@)
) age on phase L.
:\di » Check the grid voltage
AN shown on the display

(menu 412 Actual data
AC).

» If no voltage is present,
check the circuit breaker.

O L1 Frequency error

@)

"
EOS
/N

AC high frequency or low
frequency on phase L.

» Check the grid frequency
shown on the display
(menu 412 Actual data
AC).

» If no voltage is present,
check the automatic
circuit breaker.

@) DC Inj. failure

@)

N/
EOS
/N

DC feed-in failure.

» Restart the solar power
inverter. Contain your
maintenance technician if
the failure persists.

o 1 Islanding Frequency shift failure on
o phase L.
N -
0= »  Ask your electricity supply
TN company about the actual
state of the grid.

» Check the installation.

» Restart the solar power
inverter. Contain your
maintenance technician if
the failure persists.

@) PV Power too low The solar power is too low.
O Insufficient solar irradiation
N (dawn/dusk).
7/ \\_

» Check the PV cell voltage
shown on the display
(menu 416 Current data
PV).

@) Auto test failure Failure during Italian autotest.
o For Italy only.
:\d/_ » Repeat the autotest.
Q_/ PV1 ISO startup warn The startup insulation is too
;.: low.
T4
-. » Check the insulation
(@) resistance at the DC side
of the PV modules.
\\.// PV1 ISO running warn Operating insulation <150 kQ.
/f.\_\ » Check the insulation
ST resistance at the DC side
(@) of the PV modules.
Q /_ PV1+ Grounding warn DC+/DC- not correctly
;\ﬂ\; PV1- Grounding warn grounded.
-.- » Check the GND connec-
(@) tion.

» Check the GND connec-
tion fuses.

» Replace the fuse(s) if
necessary.

PV1 ISO startup fail The startup insulation is too
@)
\\ // low.
eSS
@) » Check the insulation
resistance at the DC side
of the PV modules.
QO PVl 1Is0 running fail Operating insulation <150 kQ.
;.\— » Check the insulation
/C)\ resistance at the DC side
of the PV modules.
(Q PVi+ Grounding fail PV1+/PV- not correctly
\\.// PV1- Grounding fail grounded.
- ~
/d » Check the GND connec-

tion.
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12.3.2 Internal failures

In the case of an internal failure, the message "Warning
XXX" or "Failure XXX" is displayed in the 411 Actual over-
view menu. XXX stands for a 3-digit failure number.

411 Actual data

Lfil W
Day: Wh
Warning 123

411 Actual data

Ll W
Day: Wh
Failure 351

In the case of internal failures, always contact the Delta
Support Team (see address list on the rear cover of this

manual).

12.3.3 Other LED and display messages

LEDs Display message

Message description

Fault correction

/. PV1 Voltage too low

The PV1 voltage is too

12.4 Displaying grid settings

Description EN

The actual grid settings can be displayed using the 131
View grid setup menu. The contents of this menu are
write-protected.

Menu: 131 View grid setup
Menu access: Main menu > Install settings > View
grid setup

Example display: 131 View grid setup

»Grid:
Fnom: --.--Hz

If a power limit was set when the solar power inverter was
commissioned, then the following message is displayed
before the menu opens:

The maximum power

of that inverter

has been limited to
## . H#HH#EKW

@ low. 12.5 Internal log
(@) There is insufficient solar
O irradiation. Description
» Check the PV cell The internal log contains information on the internal failures
voltage shown on that have occurred.
the display (menu
416 Current data
PV). Menu: 620 Internal log
O/ L1 Power reduction Power reduction active Menu access: Main menu > Diagnostic&Alarm > Inter-
j/.\: for L1. nal log

QO PVl PW limit to Pn

Power limiting active for
PV1.

o

PV1 Temp derating

Temperature derating
active for PV1. Reduced
electricity production.

The internal tempera-
ture of the solar power
inverter lies between +55
and +70 °C.

»  Check the ventilation
of the solar power
inverter.

» Preventdirect
sunlight from reach-
ing the solar power
inverter.

Example display: 620 Internal log

12.04.12
126 127

7:39:25

Parameter change entries have the following structure:

3rd line Date and time when the external event
occurred.
4th line Number(s) of the internal failure(s)
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12.6 LVD report
NOTE
The "Report LVD" is only available when an

LVD grid is set.
Description

In accordance with the VDE AR N 4105 specifications, the
menu 640 Report LVD shows the last five failures. You can
navigate through the list of failures using the buttons.

Menu:
Menu access:

640 Report LVD
Main menu > Diagnostic&Alarm >
Report LVD

640 Report LVD
YYVYY Error 5 VVVVY
11.04.2012 18:54:12
- Critical OverVolt

Example display:

12.7 Autotest for Italy
NOTE
"IT Autotest" is only available when the grid

has been set to IT 50/49Hz or IT 51/49Hz.
Description

610 IT Autotest
Main menu > Diagnostic&Alarm > IT
Autotest

610 IT Autotest

»Perform autotest
AT Report # 1

Menu:
Menu access:

Example display:

The solar power inverter is equipped with an autotest func-
tion that can be used to check that the interface protection
is working correctly.

The solar power inverter may be connected to the grid only
if the final result of the latest autotest is Pass.

During the autotest, the following tests are performed on the
AC side of the solar power inverter:

e Overvoltage test (OVT)

e Undervoltage test (UVT)
e High frequency test (HFT)
e Low frequency test (LFT)

The final results of the test are displayed on completion of
the autotest.

You can navigate through the list of test results using the
buttons.

The autotest is cancelled when a general failure occurs or
the operator presses the [E(] button. The final result of the
test is then "Fail". A test result of "0" is then shown for the
individual tests, and "Fail" is shown as the final test result.

Perform autotest
1. Open the menu 610 IT Autotest.

2. Usethe buttons to select the Perform autotest
entry.

610 IT Autotest

»Perform autotest
AT Report # 1

3. Press the [2] button.
— The autotest starts.
Autotest reports

On completion of the autotest, the results are shown in a
report. The reports for the last five autotests are saved.

NOTE
The following displays are examples only.

The actual autotest results may be different.
611 AT Report 1

Result: FAIL
12.10.2011 ©9:23:35
IT FW

611 AT Report 1

L1 OVT: PASS
Set: 262 V<0.10 s
Test: 220 V<0.08 s
611 AT Report 1

L1 UVT: FAIL
Set: 186 V<0.20 s
Test: 220 V<0.18 s
611 AT Report 1

il W E B E PASS
Set: 50.30Hz<0.10s
Test: 50.01Hz<0.08s
611 AT Report 1

g ELE PASS
Set: 49.70Hz<0.10s

Test: 50.01Hz<0.08s
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12. Diagnosis and maintenance

12.8 Maintenance

Danger of death from hazardous voltage
Hazardous voltage is applied to the solar
power inverter during operation. Hazardous

voltage is still present 5 minutes after all

power sources have been disconnected.

» Never open the solar power inverter.
The solar power inverter contains no
components that are to be maintained
or repaired by the operator or installer.
Opening the cover will void the war-
ranty.

Ensure that the solar power inverter is not covered during
operation.

Regularly clean the solar power inverter to prevent soiling of
the housing.
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13. Repair

13. Repair

Danger of death from hazardous voltage
Hazardous voltage is applied to the solar
power inverter during operation. Hazardous

voltage is still present 5 minutes after all

power sources have been disconnected.

» Never open the solar power inverter.
The solar power inverter contains no
components that are to be maintained
or repaired by the operator or installer.
Opening the cover will void the war-
ranty.

NOTE

The solar power inverter contains no com-
@ ponents that are to be maintained by the
operator or installer.
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14. Decommissioning, transport, stor- 14.5 Disposal
age, dlsPosaI Dispose of the solar power inverter in a technically appro- EN

priate manner according to the legal requirements of your
A DANGER country.
Danger of death or severe injuries from
dangerous voltage
» Disconnect the solar inverter from the

grid before removing or inserting the AC
connector.

A\ DANGER
Danger of death or severe injuries from
dangerous voltage
Dangerous voltages can be present at the

DC connections of the solar power inverter.
» Never disconnect the PV modules when
the solar power inverter is under load.
First switch off the grid connection so
that the solar power inverter cannot

feed energy into the grid. Then open the
DC disconnector.

» Secure the DC connections against be-
ing touched.

Danger of injury due to heavy weight
The solar power inverter is heavy (see “15.
Technical data”, p. 56). Incorrect handling can

lead to injuries.
» The solar power inverter must be lifted
and carried by two people.

14.1 Decommissioning

Switch off the AC cable to be free of voltage.
Open the DC disconnector.
Remove all cables from the solar power inverter.

Unscrew the solar power inverter from the wall bracket.

o w0 bd =

Lift the solar power inverter from the wall bracket.

14.2 Packaging

Use the original packaging or packaging of the same qual-
ity.

14.3 Transport

Always transport the solar power inverter in the original
packaging or packaging of the same quality.

14.4 Storage

Always store the solar power inverter in the original packag-
ing or packaging of the same quality. Observe the specifica-
tions relating to storage conditions described in chapter “15.
Technical data”, p. 56.
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15. Technical data

Input (DC) SOLIVIA 2.5 SOLIVIA 3.0 SOLIVIA 3.3 SOLIVIA 3.6 SOLIVIA 5.0
Maximum recommended PV 3030 W, 3700 W, 4000 W, 4300 W, 6000 W,
power (5320 W, DE/
5250 W, BE)
Rated power 2750 W 3300 W 3600 W 3850 W 5500 W (4850 W,
DE / BE)

Maximum input voltage 125 ...600 V

MPP working range 150 ... 480 V 170 ... 480V 150 ... 480 V
Rated current 72A@ 360V 9.2A@ 360V 10.0A@360V 10.7A@360V 157A@ 350V
Maximum operating current 18.2A 22.0A 240A 22.0A 22,0A
Overvoltage category Il

Output (AC) SOLIVIA 2.5 SOLIVIA 3.0 SOLIVIA 3.3 SOLIVIA 3.6 SOLIVIA 5.0
Rated apparent power " 2500 VA 3000 VA 3300 VA 3600 VA 5000 VA
Rated voltage range ? 184 ...264V

Rated current 10.9A 13.1A 144 A 15.7A 22,0A
Maximum current 17.0A 17.0A 17.0A 17.0A 34,0A
Rated frequency 50 Hz

Frequency range ? 45 ...65Hz

Power factor (cos @) ¥ > 0.99 at rated apparent power

Total harmonic distortion (THD) < 3% at rated apparent power

Nighttime consumption <20W

Typical leakage current <3.5mA

Overvoltage category Il
" Atcos ¢ =1 (VA= W)
2 Rated voltage range and frequency range are set according to the particular country requirements.
9 Cos ¢ = 0.8 capacitive ... 0.8 inductive

Safety and standards

Degree of protection IP65

Protection class 1

Soiling category Il

Configurable switch-off parameters Yes

Insulation monitoring Yes

Overload behavior Current limiting, power limiting

ENS / Grid connection guidelines DIN VDE 0126-1-1; VDE AR N 4105 (LVD)

EMC EN61000-6-2; EN61000-6-3; EN61000-3-2; EN61000-3-3

Safety IEC62109-1/-2

Mechanical data SOLIVIA 2.5 SOLIVIA 3.0 SOLIVIA 3.3 SOLIVIA 3.6 SOLIVIA 5.0
Dimensions (L x W x D) 418 x 410 x 182 mm 418 x 410 x 182 mm
Weight 21 kg 25 kg

Cooling Convection

AC connection

Wieland RST25i3S

DC connection

3 pairs of multi-contact MC4

4 Pair Multi-Contact MC4

Communication interfaces

2 x RJ45/RS485 + 1 x USB A

DC disconnector

Integrated

Display

3 LEDs, 4-line LCD
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General specification

SOLIVIA 2.5 SOLIVIA 3.0 SOLIVIA 3.3 SOLIVIA 3.6

Model name

SOLIVIA2.5 EU G4 TR SOLIVIA3.0 EU G4 TR SOLIVIA3.3 EU G4 TR SOLIVIA3.6 EU G4 TR

Delta part number EOE45010288 EOE46010287 EOE46010252 EOE46010316
Max. efficiency 96.1% 96.1% 96.0% 96.0%
EU efficiency 94.3% 94.6% 94.7% 94.6%

Maximum operating temperature -25...+70 °C
range

Operating temperature range at -25 ... +55 11
full power without derating

Storage temperature range -25...+80 [
Humidity 0...95%

Maximum operating altitude

2000 m above sea level
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16. Appendix

16.1

Overview of setting options

The following table contains an overview of all settings that can be made in the solar power inverter.

Function/Characteristic

Short description

Menu

Manual chapter

Settings for MVD/LVD grids

Functions for setting production parameters

500 User settings

“10.4 Active and reactive power con-
trol”, p. 41

Active power control

For setting the active power control for LVD and MVD
grids

510 Active PwCtrl
“10.4.2 Active power control”, p. 41

e  Power reduction

For reducing the maximum power

511 Power reduction

“10.4.2.2 Power reduction”, p. 41

e  Power/Frequency

For setting the power gradient with respect to the fre-
quency

512 Power vs freq

“10.4.2.3 Power/Frequency”, p. 42

Reactive power control

For setting the active power control for LVD and MVD
grids

520 Reactive PwCtrl

“10.4.3 Reactive power control”, p. 42

e Cos ¢ constant

For setting a fixed value for cos ¢ (inductive or capacitive)

520 Reactive PwCtrl
“10.4.3.2 Constant cos ¢”, p. 43

e  Cos phi(P) For setting a value of cos ¢ (inductive or capacitive) 520 Reactive PwCtrl
depending on the active power ratio P/P_ “10.4.3.3 cos ¢(PY’, p. 43
Options 200 Options
“10.5 Options settings”, p. 43
Shadowing For setting up the extended MPP tracking 210 Shadowing

“10.5.1 Shadowing”, p. 43

Insulation and grounding monitoring

For selecting an insulation and grounding monitoring
mode

230 Grounding

“10.5.2 Insulation and grounding
monitoring”, p. 44

Reports

Storing reports on a USB stick

For storing all available reports on USB sticks

300 USB features
“11.7 Creating reports”, p. 47

Showing reports on the display

Italian autotest report

600 Diagnostic&Alarm
“12.7 Autotest for Italy”, p. 52

Display settings

Language

For setting the display language

100 Install settings
“10.2.1 Display language”, p. 39

Date and time

For setting the date and time

110 Date and time
“10.2.2 Date and time”, p. 39

Date and time formats

For setting the date and time formats

111 Format
“10.2.3 Date and time formats”, p. 39

Backlighting and contrast

For setting the backlighting and contrast

120 Display settings
“10.2.4 Backlighting, contrast”’, p. 40

Standard menu

For selecting the display to be shown when no button has
been pressed for a certain period of time.

800 Standard
“10.6 Standard menu”, p. 44

Monitoring

RS485 (EIA 485) settings

For setting the RS485 ID and the baud rate and for
switching the termination resistor on and off

150 RS485
“10.2.6 RS485 (EIA485)”, p. 41

Insulation and grounding monitoring

230 Grounding

“10.5.2 Insulation and grounding
monitoring”, p. 44

Showing statistics

Showing statistics on the display

400 Production info

“9. Production information”, p. 37
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Function/Characteristic

Short description

Menu

Manual chapter

Saving and loading data

Storing reports on a USB stick

300 USB features
“11.7 Creating reports”, p. 47

Storing settings on a USB stick

300 USB features
“11.4 Saving settings”, p. 46

Loading settings from a USB stick

300 USB features
“11.5 Loading settings”, p. 46

Saving swap data on a USB stick

For saving the data required when replacing a solar power

inverter

300 USB features
“11.6 Saving swap data”, p. 46

Feed-in settings

Currency, revenue per kWh

For setting the currency and the revenue per kWh

471 Feed-in settings
“10.3 Grid freed-in settings”, p. 41
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16.2 Order numbers

Grounding kit

The ground connection must be installed in the immediate vicinity of the solar power inverter. We recommend using the
"Grounding Set A Solar" grounding kit from Delta.

Grounding kit Delta part number
Grounding Set A Solar EOE990000275

Cable couplings

Cable coupling types for the DC connections to the inverter. The DC+ connection of the solar power inverter is a plug, the
DC- connection is a socket.

DC connection Cable coupling type Conductor cross-section Cable sheath diameter Order number
mm? AWG mm
15125 14 3-6 32.0010P0001-UR
DC+ (Plug) Socket 5,5-9 32.0012P0001-UR
4/6 10 3-6 32.0014P0001-UR
5,5-9 32.0016P0001-UR
15125 14 3-6 32.0011P0001-UR
DC- (Socket) Plug 5,5-9 32.0013P0001-UR
476 10 3-6 32.0015P0001-UR
5,5-9 32.0017P0001-UR

MultiContact UTE kit

The Multi-Contact UTE Kit is designed to conform to the latest French standard UTE C 15-712-1. The UTE kit contains 8 DC
measuring elements, a mounting tool and an additional signaling sticker. The UTE kit allows you to conform to the DC pro-
tection and signal requirements specified in UTE C 15-712-1.

Multi-contact UTE kit Delta part number
Multi-contact UTE kit for SOLIVIA EU Solar Inverter EOE90000341
RS485 cable

RS485 connection cable Delta part number

Cable for connecting solar power inverters
Push/Pull cable from Harting, IP67, one side with a blue cable manager, the other side with a white cable manager

1.5m 3081186300
3.0m 3081186500
5.0m 3081186600
10.0 m 3081186200
20.0m 3081186400

Connecting cable from the last solar power inverter to a monitoring gateway device, e.g., Solivia Basic
Gateway, Solarlog or Meteocontrol WEB’logger

Outdoor cable, IP65, with Harting RJ45 PushPull and RJ12 plugs Contact Delta support

If you wish to assemble cables yourself in order to connect inverters to each other, then you must use cable managers from
Harting (IP67 PushPull system cable RJ45).

We recommend using a blue cable manager on one side and a white cable manager on the other side.

Cable manager Harting part number
RJI IP67 data plug Push Pull 8-pin white 09 45 145 1500
RJI IP67 data plug Push Pull 8-pin blue 09 45 145 1510

HARTING Deutschland GmbH & Co. KG (PF 2451, D-32381 Minden, www.harting.com)
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16.3 Overview of menu structure

16.3.1 "Go to menu" function

NOTE
You can use the "Go to menu" function to directly

navigate to a particular menu.
1. open the Go to menu function, press and hold the
button on the solar power inverter for at least 3
seconds.

— Go to menu opens.

Go to menu

»Menu: 000

2. Press the [2] button to enter the menu number.
— The first digit flashes.

3. Enter the first digit of the menu number using the
buttons. Press the [=2] button when you are finished.

— The second digit flashes.
4. Enter the second and third digit in the same manner.
5. Press the [9) button.

— The menu corresponding to the entered menu
number is displayed.

16.3.2 Installation settings (100)

100 Installation
Language: German
110 Date and time

Explanation
Display language
Set the date and time

120 Display settings Backlighting and contrast

Display the grid settings,

130 Grid selection change the grid

130 Grid selection

Explanation

132 Grid change

Set a different grid

133 Custom. country

Set a customer-specific grid

140 RS485

Explanation

ID: ---

If multiple solar power invert-
ers are connected via RS485,
then each inverter must have a
different ID. (1 ... 254)

Baud rate

Baud rate (2400 / 4800 / 9600
/19200 / 38400)

Termination: On

If multiple solar power invert-
ers are connected via RS485,
then the termination resistor
in the last inverter must be
switched on.

(On / Off)
16.3.3 Shadowing (210)
Mode Explanation
Disabled Monitoring is deactivated.
. High shadowing,
High time cycle: 0.5 hours
Medium Medlum shadowmg,
time cycle: 2 hours
Low Low shadowing,

time cycle: 4.5 hours

210 Shadowing

Explanation

Mode: Disabled

Disabled / High / Medium / Low

16.3.4 Insulation and grounding settings (230)

The DC side of the solar power inverter has an insulation

and grounding monitor.

The grounding can be monitored if you are compelled by
the PV module manufacturer to ground the positive or nega-

tive pole of the PV system.

A detailed description of this function is provided in chapter
“10.5.2 Insulation and grounding monitoring”, p. 44.

120 Display settings Explanation

Backlight: Auto Backlighting (Auto/On)

Contrast: 10 Contrast (1 ... 10)

130 Grid selection
131 Display grid settings

Explanation
Actual grid settings

MPPT: PV1 Cannot be changed Mode Explanation
140 RS485 Change RS485 settings ISO/GND off Monitoring is deactivated.

If an insulation failure occurs,
110 Date and time Explanation xxx Failure the solar power inverter is
Date: 2012/01/07 Date disconnected from the grid.
Time: 15:12:23 Time If an insulation failure occurs,
111 Format Date and time formats . the solar power inverter logs

xxx Warning . . .

and displays the failure but is
111 Format Explanation not disconnected from the grid.
Date: YYYY/MM/DD Date format
Time: 24h Time format (12h or 24h) 230 Grounding Explanation

ISO/GND off

PV1: ISO Warning

ISO error/warning
— GND error/warning
+ GND error/warning
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16.3.5 Save and load (300)

The USB interface must be activated before it can be

used!

Deactivate the USB interface again after use!

A detailed description of the functions is provided in the
"Saving and loading data and settings" chapter of the

manual.

412 Actual data AC

Explanation

L1 Q: ---Var

Apparent power

L1 DC inj.: ---mA

Feed-in current

416 Actual data PV Explanation
PV1 Voltage: ---V Voltage on the PV side
PV1 Current: -.--A Current on the PV side

41A Date and time

Explanation

300 USB features

Explanation

Date: 07.01.2012

Current date

State: disabled

Activate/Deactivate the USB
interface

Time: 15:05:19

Current time

Firmware update

Firmware update

Save settings

The settings should always be
saved to be on the safe side.

41B Actual insulation Explanation
R iso+: ----kQ Insulation resistance at DC+
R iso-: ----kQ Insulation resistance at DC--

420 Day statistics

Explanation

Save swap data

Save data for replacing the
device. The data can only be
loaded during initial commis-
sioning.

421 Day statistics AC

AC =AC side

422 Day statistics PV

PV = Module side

423 Day statistics ISO

ISO = Insulation

430 Week statistics

Create Reports

Create various reports

440 Month statistics

450 Year statistics

Load settings

The settings can also be
loaded during initial commis-
sioning.

460 Total statistics

470 7-day statistics

480 Event journal

Service

Start the service monitoring

16.3.6 Production information (400)

400 Production info

Explanation

410 Actual data

Actual power and energy val-
ues. Messages on the actual
operating status.

420 Day statistics

Statistics for the current day

421 Day statistics AC Explanation

Energy: ---Wh Energy

Runtime: -:--h Runtime

Revenue: -:--h Revenue

L1 Af: --.--/--.--Hz Min./Max. frequency

L1 Imax: -.--A Maximum current

L1 AU: ---/---V Min./Max. voltage

L1 Pmax: ---W Maximum active power
L1 Qmax: ---Var Maximum apparent power
L1 Qmin: ---Var Minimum apparent power

430 Week statistics

Statistics for the current calen-
dar week

431 Week statistics AC

441 Month statistics AC

440 Month statistics

Statistics for the current calen-
dar month

451 Year statistics AC

461 Total statistics AC

450 Year statistics ?tatistics for the current calen- 422 Day statistics PV Explanation
gyl PV1 Imax: ---A Max. current
460 Total statistics _Statlstlpsdfor the entire operat- PV1 Umax: Y] Max. voltage
(fg) [PEITD PV1 Pmax: —--W Max. power
i e A e Settings fﬁ\r/\f#rrency and rev- 432 Week statistics PV
IS [Pl 442 Month statistics PV
452 Year statistics PV
410 Actual data Explanation 462 Total statistics PV
411 Current overview Actual status
412 Actual data AC AC =AC side 423 Day statistics ISO Explanation

417 Actual data PV

PV = module side

R ISO max: ---kQ

Max. insulation resistance

41A Date and time

Date and time

R ISO min: ---kQ

Min. insulation resistance

41B Actual insulation

Insulation resistance value

433 Week statistics ISO

411 Current overview

Explanation

443 Month statistics ISO

Now: 200W

Actual active power

453 Year statistics ISO

Day: 2000Wh

Energy production actual day

463 Total stat. ISO

Normal operation

Current status messages

470 Feed-in settings

Explanation

Currency: EUR

Define the currency

EUR / kWh: #.H#

Define the revenue pro kWh

412 Actual data AC Explanation
L1 voltage: ---V Voltage

L1 Freq.: --.--Hz Frequency
L1 Current: -.--A Phase current
L1 P: ---W Active power
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480 Event journal

Explanation

520 Reactive power control

Explanation

481 All events

Complete overview

482 Change events

Overview of all parameter
changes

483 External events

Overview of all external events
and insulation/grounding prob-
lems

16.3.7 Active power control (510)

The active power control is available for:
e LVD grids (VDE AR N 4105)

A detailed description of the modes is provided in chapter
“10.4.2 Active power control”, p. 41.

510 Active PwCtrl

Explanation

511 Power reduction

Reduction of the active power

512 Power/Frequency

Setting of the active power
dependent on the grid fre-
quency

511 Power reduction

Explanation

Max P: ----W

Maximum active power in
watts

512 Power/Frequency

Explanation

Start freq: --.--Hz

Start frequency at which the
reduction of active power is
switched on.

(50.00 ... 55.00 Hz)

Stop freq: --.--Hz

Stop frequency at which the
feeding of active power is
stopped.

(50.00 ... 55.00 Hz)

o
“=.="/

Gradient:

Gradient for the reduction of
active power
(0 ... 150%/Hz)

16.3.8 Reactive power control (520)

The reactive power control is available for:
e LVD grids (VDE AR N 4105)

The table shows the reactive power control modes available

for LVD grids.

The number and type of configurable parameters change,
depending on the mode selected.

A detailed description of the modes is provided in chapter
“10.4.3 Reactive power control”, p. 42.

Mode

Display messages

Explanation

Disabled

Reactive power control is
deactivated

Fix. cosPhi

Setting of a constant cos ¢

Cos phi(P)

Cos @ depending on the active
power

Reactive power control deac-

Mode: disabled tivated.
520 Reactive power control |Explanation
Mode: Fix. cosPhi
.. . inductive / capacitive ||

Cos phi: ind 1.00 100 .08
520 Reactive power control |Explanation
Mode: Cos phi(P)

R inductive / capacitive ||
A Cos Phi: 1ind 1.00 100 .08
B Power ratio: ---% 1..49%

A inductive / capacitive ||
B Cos Phi: ind 1.00 100 .08
C Power ratio: ---% 50 ... 99 %

A inductive / capacitive ||
C Cos Phi: ind 1.00 100 .08

A inductive / capacitive ||
D Cos Phi: ind 1.00 100 .08

16.3.9 Diagnostic and Alarm (600)

The reports that are displayed depend on the grid that has

been set:

e Internal log (is always displayed)

e LVD report (only shown for LVD grids)

e |talian Autotest (only shown for Italian grids)

600 Diagnostic&Alarm

Explanation

610 IT Autotest

Autotest for Italian grids. Con-
tains the last five reports.

620 Internal log

Firmware update

640 LVD Reports

Report as per VDE AR N 4105.
Contains the last five failure
messages.

16.3.10Software version/inverter data (700)

700 Inverter info

Explanation

710 Software vers.

Version of the installed soft-
ware

720 Inverter data

Production date and serial
number

16.3.11 Standard menu (800)

800 Standard menu

Explanation

Menu number:

Number of the menu that is to
be displayed as the standard
menu.
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17. Certificates

17.

Certificates

Bureau Veritas
Consumer Product Services Germany GmbH

BUREALU cps-luerkheim@de bureauveritas.com

akkreditiert nach ISO 17025 durch ZLS

VERITAS und DAKKS

Priifbescheinigung
Certificate

Antragsteller: Delta Energy Systems (Germany) GmbH

Applicant: TscheulinstralBe 21

79331 Teningen, Germany.
Produkt Typ: Wechselrichter
Product type: Solar inverter
Modell: SOLIVIA5.0EUG4TR EOE46010253
Model: SOLIVIA2.5EUG4TR EOE45010288

SOLIVIA3.0EUG4TR EOE46010287

SOLIVIA3.3EUGATR EOE46010252

SOLIVIA3.6EUG4TR EOE46010316
Schutzarten: P65,
IP-Code

0.g. Models bestand die Priifung nach
A ropusenrahve test samprs of above stated model passed the tests according to

Norm: IEC 60529:1989 + A1:1999 / EN 60529:1991 + A1:2000
Standard:
Bericht Nr: 11THO375-IEC60529_0
Report No.:
Zertifikat Nr.: 11213

Certificate No.:

Datum: 14.10.2011
Issued:

TRUNGDS
Zertifizierungssfelle
Ceniﬁcar: ment,

Bureau Veritas Consumer
Products Services

Germany GmbH
Businesspark A%
86842 Tirkheim

Duitsland
BUREAU +49(0)4074041-0
VERITAS cps-tuerkheim@de.bureauveritas.com

Potvrzeni o nezavadnosti

Zadatel: Delta Energy Systems (Germany) GmbH
Tscheulinstrae 21
79331 Teningen

Némecko

Vyrobek: Samostatna spinaci stanice mezi sitové paralelnim
vlastnim vyrobnim zafizenim a vefejnou siti nizkého
napéti.

Model: Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUG4TR EOE46010252,
Solivia3.6EUG4TR EOE46010316

Pouzivani podle uréeni:

Samostatna spinaci stanice s jednofazovou kontm\ou sité dle DIN V VDE \/ 0126- 1 1 2006 02 (s CR
odchylkami podle EN 50438:2007, Annex A*) p zafizeni s j

napdjenim pomoci ménice do sité vefejného napajenl Samostatna spinaci stanice je integracni
soucasti vyse y i Tato slouzi jako nahrada za spinaci
stanici s déllu funkei, ktera je kdykoli pfistupna provozovateli rozvodné sité (VNB).

* 85%<V<115%

49,5Hz<f<50,: 5H1

Zku$ebni podklady:
EN 50438:2007, DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02, a ,Vlastni vyrobni zafizeni u sité
nizkého napéti, 4. vydani 2001, smémice pro pripojeni a paralelni provoz viastnich vyrobnich zafizeni
u sité nizkého napéti* s dopliiky VDN, stav 2005, od elektrarenského svazu (VDEW) a od svazu
provozovatelti sité (VDN).

Reprezentativni zkusebni vzorek vjSe jmenovaného vyrobku odpovida bezpeénostné technickjm
pozadavkim platnym v okamziku vydani tohoto certifikétu, vedenych zkuebnich podkladd pro
pouzivéni podle uréeni.

Cislo zpravy: 11TH0316-EN50438_CZE
Cislo cert U12-0356
Datum: 2012-04-25 Platnost do: 2015-04-24

Achim Hanchen

Bureau Veritas

Consumer Products Services Germany.
GmbH

Businesspark A6

86842 Turkheim

Deutschland

+49 (0)40 7 40 41-0
cps-tuerkheim@de.bureauveritas.com

BUREAU Accreditad according to SO 17025 and
[ VERITAS |

Zertifikat

Certificate
Zertifikatsinhaber: Delta Energy Systems (Germany) GmbH
Holder of certificate: ~ Tscheulinstrafe 21
79331 Teningen
Germany
Ferti Delta ia), s.r.o.
Factory: Priemyselna ulica 4600/1

Produkt-Typ:
Product type:
Modell:
Model:
Leistung:
Ratings:

Certification mark:

Norm:
Standard:

Bericht Nr:
Report no.:
Zertifikat Nr.:
Certificate no.:
Datum:
Issued:

Zulassungszeichen:

01841 Dubnica nad Vahom
Slovakia

grid connected photovoltaic inverte

Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR EOE46010287,
Solivia3.3EUG4TR EOE46010252, Solivia3. 6EUG4TR EOE46010316
siehe Anhang

see anex

‘accordingto
IEC 62109-1:2010 (1st Edition), EN 62109-1:2010, IEC 62109-2:2011,
EN 62109-2:2012, EN 61000-6-2:2005, EN 61000-6-3:2007 + A1:2011

und
and comply with the requirements of safety and health of the GS-Act Produktsicherheitsgesetz

11THO316

12-107

2012-05-14 Giiltig bis:  2017-05-13
Valid until:

Der schaffen,

22 ProdSG). Der
Sarechit o g. Produkd it dem G5 Zechen i dc abgsbicean et s, Grunags T  Atiateing

d actions of
ed 1o apply the GS-mark as

ProdSG). The holder of thi

reguiations of the GS-contract, which

Zadatel:

Vyrobek:

Model:

Bureau Veritas Consumer
Products Services

Germany GmbH
Businesspark A%
> 86842 Tirkheim
Duitsland
BUREAU +49(0)4074041-0

cps-tuerkheim@de.bureauveritas.com

| VERITAS |

Potvrzeni o nezavadnosti

Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21

79331 Teningen

Némecko

Samostatna spinaci stanice mezi sitové paralelnim
vlastnim vyrobnim zafizenim a vefejnou siti nizkého
napéti.

Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR
EOE46010287, Solivia3.3EUG4TR EOE46010252,
Solivia3.6EUG4TR EOE46010316

Pouzivani podle uréeni:

Samostatna spinaci stanice s jednofazovou konlrclou sité dle DIN V VDE V 0126- 1 1: 2006 02 (s CR

odchylkami podie EN 50438:2007, Annex A*) pr zafizeni s
napajenim pomoci ménice do sité vefejného napa]enl Samostatna spinaci stanice je integracni
soucasti vyse ych ménicu s Tato slouz jako nahrada za spinaci

Stanic o dliclfurk, iora o kdykel pristupna provosovatel osvodng 5 (VNB).
*85%<V<115%
49,5Hz<f<50,5Hz

Zku$ebni podklady:

EN 50438:2007, DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02, a ,Vlastni vyrobni zafizeni u sité
nizkého napéti, 4. vydani 2001, smérnice pro pfipojeni a paralelni provoz viastnich vyrobnich zafizent
u'sité nizkého napéti® s dopliiky VDN, stav 2005, od elektrarenského svazu (VDEW) a od svazu
provozovateli sité (VDN).

Reprezentativni zkusebni vzorek vySe jmenovaného vyrobku odpovida bezpegnostné technickym
pozadavkm platnym v okamziku vydani tohoto certiikétu, uvedenych zkusebnich podkladd pro
pouzivani podle urdeni.

Gislo zpravy: 11TH0316-EN50438_CZE
Cislo certifikatu: U12-0356
Datum: 2012-04-25

Platnost do: 2015-04-24

Achlm Hanchen
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17. Certificates

Bureau Veritas Consumer
Products Services
Germany GmbH

Businesspark A%
86842 Tirkheim

Germania
+49 (0) 40 740 41 -

[BUREAU | 0
VERITAS cps-tuerkheim@de. bureauveritas.com

Dichiarazione di conformita

NOME ORGANISMO Bureau Veritas Consumer Products Services Germany GmbH

. ACCREDITAMENTO n° ZLS 116/0076. 421-1/2
CERTIFICATORE: Rif. DIN EN 45011

Data validita: 31-Marzo-2016

OGGETTO: GUIDA PER LE CONNESSIONI ALLA RETE ELETTRICA DI ENEL
DISTRIBUZIONE, Ed. 2.2, Dicembre 2011
REGOLE TECNICHE DI CONNESSIONE DI CLIENTI PRODUTTORI ALLE RETI
ENEL IN BASSA TENSIONE

TIPOLOGIA APPARATO A CUI SI RIFERISCE LA DICHIARAZIONE:

DISPOSITIVO DI PROTEZIONE DI DISPOSITIVO DI DISPOSITIVO DI
INTERFACCIA INTERFACCIA CONVERSIONE GENERAZIONE
STATICA ROTANTE
X X X
COSTRUTTORE: Delta Energy Systems (Germany) GmbH

Tscheulinstrale 21
79331 Teningen
Germania

Solivia2.5 | Solivia3.0 | Solivia3.3 | Solivia3.6
MODELLO: EUG4TR EUG4TR EUG4TR EUG4TR
: EOE450102 | EOE460102 | EOE460102 | EOE460103
88 87 52 16
POTENZA NOMINALE: 2,5 kW 3,0 kW 3,3 kW 3,6 kW
VERSIONE FIRMWARE: IT FW 00.01.00
NUMERO DI FASI: monofase
RIFERIMENTO: ispositivo non & equi jiato con di a

Il
bassa frequenza.

RIFERIMENTI DEI LABORATORI CHE HANNO ESEGUITO LE PROVE:
Bureau Veritas Consumer Products Services Germany GmbH
ACCREDITAMENTO n° ZLS 116/0076. 421-1/2

Rif. DIN EN ISO/IEC 17025

Data validita: 31-Marzo-2016
Esaminati i Fascicoli Prove n°11TH0316-ENELguide, emessi dal laboratorio
Bureau Veritas Consumer Products Services Germany GmbH
Si dichiara che il prodotto indicato & conforme alle prescrizioni ENEL
Numero di certificato: U12-0338

Data di emissione: 2012-04-24

Achim Hanchen
FIRMA RESPONSABILE

Bureau Veritas Consumer
Products Services

Germany GmbH
Businesspark A96
— 86842 Turkheim
Germany
BUREAU +49(0)4074041-0
VERITAS cps-tuerkheim@de.bureauveritas.com

Certificate of compliance

Applicant: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21
79331 Teningen

Germany

Product: ic di ion device b ag
and the public low-voltage grid

Model: Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUG4TR EOE46010252,
Solivia3.6EUG4TR EOE46010316

Use in accordance with regulations:

Automatic ion device with single-phase mains i in with DIN V VDE V
0126-1-1:2008-02 for ic systems with a single-phase parallel coupling via an inverter in the
public mains supply. The automatic disconnection device is an integral part of the aforementioned
inverter. This serves as a replacement for the disconnection device with insulating function which the
distribution network provider can access at any time.

Applied rules and standards:

DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02 and ,Generator at the public low-voltage grid, 4th
edition 2001, guideline for connection and parallel operation of generators in the public low-voltage
grid” with VDN additions (2005) from the German Electricity Association (VDEW) and Association of
network operator (VDN).

At the time of issue of this certificate the safety concept of an aforementioned representative product
corresponds to the valid safety specifications for the specified use in accordance with regulations

Report number: 11TH0316-VDE0126
Certificate number:  U12-0400
Date of issue: 2012-05-04 Valid until: 2015-04-22

Achim Hanchen

Bureau Veritas Consumer
Products Services

Germany GmbH
Businesspark A%
86842 Turkheim

Germany
BUREAU +49(0) 40740 41-0
VERITAS cps-tuerkheim@de bureauveritas.com

Certifikat o zhode

Ziadatel: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21

79331 Teningen

Nemecko

Produkt: Zariadenie na automatické odpojenie medzi
generatorom a verejnou elektrickou sietou s nizkym
napatim

Model: Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUG4TR EOE46010252,
Solivia3.6EUG4TR EOE46010316

Pouzitie v stlade s predpismi:
Zariadenie na automatické odpojenie s dohfadom nad jednofazovym napajanim v stlade s normou DIN

V VDE V 0126-1-1:2006-02 pre systémy s spojenim
prostrednictvom prevodnika v ramci napéjania z verejnej elektrickej siete. Zariadenie na automatické
odpojenie je i sucastou i

Pouzité pravidla a Standardy:

Norma DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02 a predpis ,Generator at the public low-
voltage grid, 4th edition 2001, guideline for connection and parallel operation of generators in the public
low-voltage grid” (Generator vo verejnej elektrickej sieti s nizkym napétim, 4. vydanie, 2001, predpis na
pripojenie a paralelnii_prevadzku generatorov vo verejnej elekirickej sieti s nizkym napétim) s
dodatkami asociacie VDN (2005) od nemeckej asociacie pre elektrinu (VDEW) asociacie sietovych
operatorov (VDN).

i cnosti : i produktu a v case ia tohto
certifiktu platnym bezpetnostnym poziadavkam na uréeny sposob pouZitia v sulade s predpismi.

Gislo spravy: 10TH0316-VDE0126
Cislo certifikatu: U12-0399
Datum vystavenia:  2012-05-04 Platnost do: 2015-04-22

Achim Hanchen

Bureau Veritas Consumer
Product Services GmbH

Businesspark

86842 Tirkheim

Allemagne

+49 (0) 40 74 041-0
BUREAU cps-tuerkheim@de bureauveritas.com

VERITAS

Certificat de conformité

Demandeur: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21

79331 Teningen

Allemagne
Produit: Dispositif de dé i i entre un
générateur et le réseau public a basse tension
Modéle: Solivia2.5SEUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUGATR EOE46010252,
Solivia3.6EUG4TR EOE46010316

A utiliser conformément aux réglementations:

Dispositif de coupure avec une du réseau 6 ément a DIN
VDE V 0126-1-1:2006-02 pour des systémes photovoltaiques avec un couplage paralléle monophasé via
un convertisseur a alimentation électrique publique. Le dispositif de coupure automatique fait partie
intégrante de ce convertisseur. Il remplace I'appareil de déconnexion avec une fonction isolante, auguel
le fournisseur du réseau de distribution peut accéder & tout moment.

et normes

DIN V VDE V 0126-1-1:2006-02 et «générateur au réseau électrique basse tension public, quatriéme
édition 2001, le guide de connexion et d'utilisation paralléle des générateurs dans le réseau électrique
basse tension » avec les additions de VDN (2005), provenant de I'Association allemande du service
public de I'énergie «VDEW» et I'Association d'opérateur d'un réseau «VDN».

Un é é if des produits és ci-dessus aux exigences de sécurité
technique en vigueur & la date d'émission de ce certificat pour l'usage spécifié et conformément & la
réglementation.

Numéro de rapport: 11TH0316-VDE0126
Numéro de certificat:  U12-0401
Délivré le: 2012-05-04 Valide jusqu’au :  2015-04-22

Achim Hanchen
CERTIFICATION
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Bureau Veritas Consumer
Products Services
Germany GmbH

Businesspark A9

86842 Turkheim

Deutschiand
BUREAU +49(0)40 740 41-0
VERITAS cps-tuerkheim@de bureauveritas.com

Unbedenklichkeitsbescheinigung

Antragsteller: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21
79331 Teningen
Deutschland

einer netzparallelen

Ei und dem
Niederspannungsnetz
Modell: Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUGATR EOE46010252,
Solivia3.6EUG4TR EOE46010316

Ver

mit einphasi 9 gemaE DIN V VDE V 0126 1-1:2006-02 fiir

mit einer i i n das Netz der
5 ist Inlegraler i

Wechselrichter mit Tromnirato, Diese dient als Ersatz fir eine jederzeit dem Verteilungsnetzbetreiber

(VNB)

Priifgrundlagen:

DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02 und Eigenerzeugungsanlagen am
Niederspannungsnetz, 4. Ausgabe 2001, Richtiinie fiir Anschiuss und Parallelbetrieb von
i am Ni * mit VON Stand 2005 vom Verband
der Elektrizitatswirtschaft (VDEW) und vom Verband der Netzbetreiber (VDN).

Ein représentatives Testmuster der oben genannten Erzeugnisse entspricht den zum Zeitpunkt der
dieser geltenden der aufg
fiir die 9

Bericht Nummer: 11TH0316-VDE0126
Zertifikat Nummer:  U12-0334
Datum: 2012-04-23 Giiltig bis: 2015-04-22

e

Achim Hanchen

Bureau Veritas Consumer
Products Services

Germany GmbH
Businesspark A%
2 86842 Tirkheim
Dusland
BUREAU +49(0)40 740 41 -0
VERITAS cps-tuerkheim@de bureauveritas.com

Verklaring van geen bezwaar

Aanvrager: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21
79331 Teningen

Duitsland
Product: Automatisch schakelstation tussen een netparallelle
p il ie en het op i
Model: Solivia2.5EUGATR / EOE45010288, Solivia3.0EUG4TR /

EOE46010287, Solivia3.3EUG4TR / EOE46010252,
Solivia3.6EUGA4TR / EOE46010316

Reglementair voorgeschreven gebruik:

met i conform C10/11 — 06.2012 , Bijlage 3
voor ische i jes met een i door middel van gelijstroom-
wisselstroommutator in het net van de openbare Het vormt

een integraal bestanddeel van de hoger vermelde gelijkstroom-wisselstroommutators.

Controlebasis:
C10/11-06.2012 *
DIN V VDE V 0126-1-1:2006-02

F.A.Q. C dela iption C10/11 - 06.2012
Onmiddelljke scheiding bij een maximale spanning van 264,5V.
Scheiding van een gemiddelde spanning van 253,0V, binnen 10 minuten volgens de EN50160.

Een representatief testpatroon van het hoger vermelde product voldoet aan de op het moment van de
uitreiking van dit attest geldende veiligheidstechnische eisen van de vermelde controlegrondbeginselen
voor een reglementair voorgeschreven gebruik.

Rapportnummer: 11TH0316-C10-11
Certificaatnummer:  U12-0567
Datum: 2012-06-19 Geldig tot: 2015-06-18

Achim Hanchen

Bureau Veritas Consumer
Products Services

Germany GmbH
Businesspark A%
86842 Trkheim
Germany
BUREAU +49(0) 40740410
VERITAS cps-tuerkheim@de.bureauveritas.com

MoToTroINTIKO CUUHOPPWONG

Artwv: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21
79331 Teningen

lFeppavia
Mpoidv: ZUOKEUN AUTONATNG ATTOCUVEECNG HETASU pIag
YEVVATPIOG Kal TOU Snpéoiou SikTUou XapnArg Tdong
Movtého: Solivia2.5SEUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUG4TR EOE46010252,
Solivia3.6EUG4TR EOE46010316

MpoBAetrépevn xpfion oK HE TOUG Houg:

SUOKEUR auTopaTg pe emipnon 6 BiKT6oU OUGWVA pe To Tp6TUTIO DIN V
VDE V 0126-1-1:2006-02* yia e MNAN Ze0En péow
avacTpogéa oTo Snuéoio iktuo Tapoxiis. H ouokeu uumpurng amoovBeong amoTeel avaméomaoTo
THANG TOU v Adyw pogéa. ™ ouoKeun e Aeoupyia omv
oTToia 0 TIGPOX0S BIKTOU élavoung UTTOpEi val éxel TTPGORAC avd TTAoa OTiypr.

e Go-jocon <0.5% 100 (OVOUTITIG EVGANOOUEYO pEGHC)

49,5 Hz</<50,5 Hz (nmeipunxe mepioxés)
47,5 Hz</<51 Hz (owres mepioxés)
Xpovog anoouvBeans <500 ms

voc smavagivseanc >180 s

E@apuolopevol Kavoviguoi Kal TpoTuTra:

DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02 kai «[eviTpia 6T0 3npidoio SikTuo XapnArg Tdong, 4"
£kBoon 2001, 0Bnyia yia T GGVEGN Kai TapdAANAN AETOUpYIa YEVNTPIGY GTO SMUGGIo BIKTUO XapNAMC
T80nG» pe TPooBAKkeg VDN (2005) ammé T yeppaviki ‘Evwon NAEKTpoMoyikiv £pywv (VDEW) Kkai Tnv
“EvWon XEIPIOTGV BikTUwV (VDN).

Belypia Twv Tpoit ™
aogéheiag Trou 1oxUouv T oTIvR ExBo6MG 100 MapEVToG METONONTXOG i TV KGBoPGUEVY Xoren
GUNQWVA HE TOUG KavOVIoHOUs.

Ap1Buég avagpopdg: 11TH0316-VDE0126_GRE
Ap1Bpdg migToTrOINTIKOU:  U12-0385
Huepopnvia ékdoong: 2012-04-30 loxoer éwg: 2015-04-29

Achlm Hanchen

Bureau Veritas Consumer
Products Services
Germany GmbH

Businesspark A%

86842 Tirkheim

Allemagne
BU R EAU +49 (0)40 740 41 -0
VERITAS cps-tuerkheim@de bureauveritas.com

Certificat de conformité

Demandeur: Delta Energy Systems (Germany) GmbH
TscheulinstraBe 21
79331 Teningen

Allemagne

Produit: Di itif de di i i entre un
générateur et le réseau public a basse tension

Modele: Solivia2.5EUG4TR / EOE45010288, Solivia3.0EUG4TR /
EOE46010287, Solivia3.3EUG4TR / EOE46010252,

Solivia3.6EUG4TR / EOE46010316
A utiliser conformé aux ré
Dispositif de coupure i du réseau
C10M11 - 06 2012 appendloe 3, pour des syslemes photovoltaiques avec un couplage paral\e\e
dans électrique publique. Le dispositif de coupure

automatique fait pame intégrante de ce convertisseur. Il remplace le appareil de déconnexion avec une
fonction isolante, auquel le fournisseur du réseau de distribution peut accéder & tout moment.

et normes

C10/11 - 06.2012*
DIN V VDE V 0126-1-1:2006-02

“F.A.Q. C dela ion C10/11 - 06.2012
Séparation immédiate & une tension maximale de 264,5V.
La séparation d'avec une tension moyenne de 253,0V & 10 minutes selon le EN50160.

Un des produits mentionnés ci-dessus 4 la date de la del
ce certificat en vigueur des exigences de sécurité technique et pour I'uilisation conformément & sa
destination.

Numéro de rapport: 11TH0316-C10-11
Numeéro de certificat: U12-0568
Délivré le: 2012-06-19 Valide jusque le:  2015-06-18

Achim Hanchen
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17. Certificates

Bureau Veritas Consumer
Products Services

Bureau Veritas Consumer
Products Services

Germany GmbH Germany GmbH
Businesspark A9 Businesspark A%
86842 Turkheim > 86842 Tirkheim
Germania
BUREAU R ra041-0 BUREAU S 140410
VERITAS cps-tuerkheim@de.bureauveritas.com VERITAS cps-tuerkheim@de.bureauveritas.com

CepTudmKaT 32 CLOTBETCTBME Certificat de conformitate

3anButen: Delta Energy Systems (Germany) GmbH
Tscheulinstrae 21

79331 Teningen Solicitant: Delta Energy Systems (Germany) GmbH

TscheulinstraBe 21

Tepmanus 79331 Teningen
Mpoaykr: ABTOMaTUYEH U3KNIOYBaTEN MeXAY reHepaTop u Germania
obujecTBeHaTa enekTpopasnpeaenuTenHa Mpexa 3a Produs: Di itiv de d 3 intre
P g
HUCKO Hanpexerne si retelele de distributie publica de joasa tensiune
Mogen: Solivia2.5EUG4TR EOE45010288, Solivia3.0EUG4TR . . .
EOE46010287, Solivia3.3EUG4TR EOE46010252, Model: Solivia2. 5SEUG4TR EOE45010288, Solivia3.0EUG4TR

EOE46010287, Solivia3.3EUG4TR EOE46010252,
Solivia3.6EUG4TR EOE46010316

Solivia3.6EUG4TR EOE46010316

EKcnnoartauvs B CLOTBETCTBUE C HOPMATUBHUTE aKTOBe: L ’ L -
A se utiliza in conformitate cu reglementarile de mai jos:

c Mpexa B ¢ DIN V VDE V 0126-1- 3 ) - ) ) 3
1:2006-02 33 (OTOBONTAMUHM CHCTEMM C WHBEpTOp B Dispozitiv de deconectare automata a sistemului de supraveghere a curentului monofazic in
mpexa. V3KmlouBaTeN e HepasaenHa YacT ot conformitate cu DIN V VDE V 0126-1-1:2006-02 pentru sistemele fotovoltaice cu o bransare
ropeynoMeHaTiia MHBEPTOP. ChHILOTO CAYKM 3a Ha c ymiums, [0 monofazicd paraleld prin intermediul unui invertor din cadrul retelei publice de alimentare cu energie
Koeto Ha Mpexa MOXe /1a Ma [OCTbN N0 BCSIKO BpeMe. electricé. Dispozitivul de deconectare automata este parte integranta a invertorului mentionat anterior.

Acesta serveste drept inlocuitor al dispozitivului de deconectare cu functia de izolare, pe care furnizorul
retelei de distributie il poate oricand accesa

| " pTH:
DIN V VDE V 0126-1-1 (VDE V 0126-1-1)200602 u ,lewepatop & obuiecTeenata

eNeKTPOpasnpeaenviTenHa Mpexa 3a HICKO Hanpexerue, 4 uananve, 2001 T., UHCTPYKUNA 3a CBLP3BAHE 1 Reguli si standarde aplicabile:
Ha

B Mpexa 3a HICKO DIN V VDE V 0126-1-1 (VDE V 0126-1-1):2006-02 §i ,Generator in refeaua de distributie publica de
" ¢ VDN (2005) Ha [ Ha Ha joasa tensiune, editia a patra, 2001, norme privind racordarea si functionarea in paralel a
enextpoenepria [German  Electricity ion (VDEW)] Ha generatoarelor din refeaua de distributie publics de joasa tensiune” cu adugirile VDN (2005) din

[Association of network operator (VDN)]. partea Asociatiei Germane de Electricitate (VDEW) si a Asociatiei Operatorilor de Retea (VDN).

sa Ha NPOAYKT OTTOBAPS, KbM MOMEHTa Ha Conceptul de siguranta al i { la momentul emiterii
vafiaBare Ha T3 Ha sa 3a B prezentului certificat, specificatiilor valide privind siguranta pentru utilizarea specificata in conformitate
CbOTBETCTBUE C HOPMATUBHUTE aKTOBE. cu normele.

Homep Ha 11TH0316-VDE0126

npotokona:

Homep Ha U12-0603 Numar raport: 11TH0316-VDE0126

cepTudmkara:

Numar certificat: U12-0604

Aara Ha uspasane:  2012-06-28 Banupen po: 2015-06-27 Data emiterii: 2012-06-28 Valabil pand la:  2015-06-27

Achim Hanchen
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Delta Energy Systems (Germany) GmbH
Tscheulinstralle 21

79331 Teningen

GERMANY

Sales email: sales@solar-inverter.com
Support email:  support@solar-inverter.com
Sales hotline: +49 180 10 SOLAR (76527)

Su%port hotline: +49 180 16 SOLAR (76527) )
Monday to Friday, 8 AM to 5 PM (CET, except for public holidays) (3.9 c/min)

Delta Energy Systems (Italy) Srl

Via | Maggio 6

40011 Anzola dell’Emilia (BO)

ITALY

Phone: +39 051 733045

Fax: +39 051 731838

Email: support.italy@solar-inverter.com

Delta Energy Systems (Spain) S.L.
Calle Luis I, n° 60, Nave 1A. P.l. de Vallecas
28031 Madrid

SPAIN

Phone: +34 91 223 74 27

Fax: +34 91 332 90 38

Email: support.spain@solar-inverter.com

Delta Electronics (Slovakia) s.r.o.
Priemyselna ulica 4600/1
018 41 Dubnica nad Vahom

SLOVAKIA

Phone: +421 42 4661 230

Fax: +421 42 4661 131

Email: support.slovakia@solar-inverter.com

www.solar-inverter.com

2012/07/09

A NELTA
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